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Safety information
Connect the power supply cord to a properly grounded electrical outlet that is near the product and easily
accessible.

CAUTION—SHOCK HAZARD: Do not set up this product or make any electrical or cabling connections,
such as the power supply cord or telephone, during a lightning storm.

Refer service or repairs, other than those described in the user documentation, to a professional service person.

This product is designed, tested, and approved to meet strict global safety standards with the use of specific
Lexmark components. The safety features of some parts may not always be obvious. Lexmark is not responsible
for the use of other replacement parts.

CAUTION—SHOCK HAZARD: Make sure that all external connections (such as Ethernet and telephone
system connections) are properly installed in their marked plug-in ports.

CAUTION—POTENTIAL INJURY: This product uses a laser. Use of controls or adjustments or
performance of procedures other than those specified herein may result in hazardous radiation
exposure.

This product uses a printing process that heats the print media, and the heat may cause the media to release
emissions. You must understand the section in your operating instructions that discusses the guidelines for
selecting print media to avoid the possibility of harmful emissions.

CAUTION—HOT SURFACE: The fuser and the inside of the printer near the fuser may be hot. To reduce
the risk of injury from a hot component, allow the surface to cool before removing paper from this area.

CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a hot
component, allow the surface to cool before touching.

CAUTION—POTENTIAL INJURY: Do not twist, bind, crush, or place heavy objects on the power cord.
Do not subject the power cord to abrasion or stress. Do not pinch the power cord between objects such
as furniture and walls. If the power cord is misused, a risk of fire or electrical shock results. Inspect the
power cord regularly for signs of misuse. Remove the power cord from the electrical outlet before
inspecting it.

CAUTION—SHOCK HAZARD: When accessing the system board, turn the printer off, and then unplug
the power cord from the wall outlet before continuing. If you have other devices attached to the printer,
then turn them off as well and unplug any cables going to the printer.

CAUTION—SHOCK HAZARD: If you are installing an optional drawer after setting up the printer, then
turn the printer off and unplug the power cord from the wall outlet before continuing.

CAUTION—SHOCK HAZARD: If you are accessing the system board or installing optional hardware or
memory devices sometime after setting up the printer, then turn the printer off, and unplug the power
cord from the wall outlet before continuing. If you have any other devices attached to the printer, then
turn them off as well, and unplug any cables going into the printer.

CAUTION—SHOCK HAZARD: To avoid the risk of electric shock when cleaning the exterior of the
printer, unplug the power cord from the wall outlet and disconnect all cables from the printer before
proceeding.

CAUTION—POTENTIAL INJURY:  Before moving the printer, follow these guidelines to avoid personal
injury or printer damage:

• Turn the printer off using the power switch, and then unplug the power cord from the wall outlet.

• Disconnect all cords and cables from the printer before moving it.
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• Lift the printer off of the optional drawer and set it aside instead of trying to lift the drawer and printer at the
same time.

Note: Use the handholds located on both sides of the printer to lift it off the optional drawer.
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Learning about the printer

Finding information about the printer
Description Where to find

The Setup information gives you instructions for setting
up the printer. Follow the set of instructions for local,
network, or wireless, depending on what you need.

You can find the Setup information on the side of the printer
box or on the Lexmark Web site at www.lexmark.com.

Description Where to find

The Help gives you instructions for using the
software.

While in any Lexmark software program, click Help, Tips > Help, or
Help > Help Topics.

Description Where to find (North America) Where to find (rest of world)

Telephone support Call us at

• US: 1‑800‑332‑4120

Monday–Friday (8:00 AM–11:00 PM
ET)

Saturday (Noon–6:00 PM ET)

• Canada: 1‑800‑539‑6275

Monday–Friday (8:00 AM–11:00 PM
ET)

Saturday (Noon–6:00 PM ET)

• Mexico: 001‑888‑377‑0063

Monday–Friday (8:00 AM–8:00 PM
ET)

Note: Telephone numbers and support
times may change without notice. For
the most recent telephone numbers
available, see the printed warranty
statement that came with your printer.

Telephone numbers and support hours
vary by country or region.

Visit our Web site at www.lexmark.com.
Select a country or region, and then
select the Customer Support link.

Note: For additional information about
contacting Lexmark, see the printed
warranty that came with your printer.

E-mail support For e-mail support, visit our Web site:
www.lexmark.com.

1 Click SUPPORT.

2 Click Technical Support.

3 Select your printer type.

4 Select your printer model.

5 From the Support Tools section,
click e-Mail Support.

6 Complete the form, and then click
Submit Request.

E‑mail support varies by country or
region, and may not be available in some
instances.

Visit our Web site at www.lexmark.com.
Select a country or region, and then
select the Customer Support link.

Note: For additional information about
contacting Lexmark, see the printed
warranty that came with your printer.
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Printer configurations

Basic model
The following illustration shows the printer front with its basic features or parts:

1 Front door release button

2 Paper stop

3 Standard exit bin

4 Printer control panel

5 System board door

6 Standard 250‑sheet tray (Tray 1)

7 Multipurpose feeder door

8 Front door

The following illustration shows the printer back with its basic features or parts:
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1 Rear door

2 Ethernet port

Note: The Ethernet port is a feature on network models only.

3 USB port

4 Parallel port

5 Printer power cord socket

6 Power switch

7 Locking device
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Configured models
The following illustration shows the printer configured with an optional 250‑sheet drawer:

1 Front door release button

2 Paper stop

3 Standard exit bin

4 Printer control panel

5 System board door

6 Standard 250‑sheet tray (Tray 1)

7 Optional 250‑sheet drawer (Tray 2)

8 Multipurpose feeder door

9 Front door
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The following illustration shows the printer configured with an optional 550‑sheet drawer:

1 Front door release button

2 Paper stop

3 Standard exit bin

4 Printer control panel

5 System board door

6 Standard 250‑sheet tray (Tray 1)

7 Optional 550‑sheet drawer (Tray 2)

8 Multipurpose feeder door

9 Front door
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Understanding the printer control panel

Item Description

1 Menus button ( ) • Opens the menus.

Note: The menus are available only when the printer is in the Ready state.

• Returns the printer control panel to the top level menu screen if pressed while in a
menu.

2 Display Shows messages that communicate the status of the printer or indicates possible
printer problems that must be resolved

3 Indicator light Indicates the printer status:

• Off—The power is off.

• Blinking green—The printer is warming up, processing data, or printing.

• Solid green—The printer is on, but idle.

• Blinking red—Operator intervention is needed.

4
Stop button ( ) • Press once to exit the menus and return to Ready.

• Press to stop printer activity, such as printing or downloading fonts.

• When printing, pressing  causes Stopping to appear momentarily. Then the
Stopped screen appears offering a list of settings that you may select.

5 Right arrow button • Press to scroll through menus, menu items, or settings, or to move between screens
and menu options.

• Press to scroll through settings or text. For menu items with numeric values, such
as Copies, press and hold an arrow button to scroll through the settings. Release
the button when the needed number appears.

6
Select button ( )

• Opens a menu and displays the first item in the menu (called a menu item)

• Opens a menu item and displays the available values or settings. The current
default setting is indicated by an asterisk (*).

• Saves the displayed value as the new user default setting

Note: When a new setting is saved as the user default setting, it remains in effect
until new settings are saved or until factory defaults are restored. Settings chosen
from a software program can also change or override the user default settings
selected from the printer control panel.
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Item Description

7 Left arrow button Performs the same functions as the right arrow button. See the description for the right
arrow button.

8 Back button ( ) Returns the display to the previous screen

Using the standard exit bin and paper stop
The standard exit bin holds up to 150 sheets of 20 lb paper. It collects print jobs facedown. The standard exit
bin includes a paper stop that keeps paper from sliding out the front of the bin as it stacks. The paper stop also
aids in neater stacking of the paper.

To open the paper stop, pull it so it flips forward.

Notes:

• Do not leave the paper stop in the open position if you are printing on transparencies. Doing so may
cause creases in the transparencies.

• When moving the printer to another location, make sure the paper stop is closed.
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Additional printer setup
After completing any additional printer setup, print a menu settings page to verify that all printer options are
installed correctly. See “Printing a menu settings page” on page 24 for more information. The option names
appear on this page if they are installed correctly. Since you have not made any setting changes yet, if you print
the page now it lists all the factory default settings. Once you select and save other settings from the menus,
when you print this page, the user default settings are listed on the page.

Saved settings are called user default settings because you, the user, selected the values and saved them as
the new settings.

A user default setting remains in effect until you access the menu again, choose another value, and save it. An
asterisk (*) appears next to each factory default setting, but once a user default setting is in effect, the asterisk
appears next to the user default setting on the display.

Factory default settings can be restored. See “Restoring the factory default settings” on page 110 for more
information.

Installing internal options
CAUTION—SHOCK HAZARD:  If you are installing internal options, memory cards, flash memory or a
firmware card after setting up the printer, turn the printer off and unplug it from the wall outlet before
continuing. If you have other devices attached to the printer, then turn them off as well and unplug any
cables going to the printer.

You can customize your printer connectivity and memory capacity by adding optional cards. The instructions
in this section explain how to install the available cards; you can also use them to locate a card for removal.

Available internal options

Memory cards
• Printer memory

• Flash memory

• Fonts
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Accessing the system board to install internal options
CAUTION—SHOCK HAZARD: When accessing the system board, turn the printer off, and then unplug
the power cord from the wall outlet before continuing. If you have other devices attached to the printer,
then turn them off as well and unplug any cables going to the printer.

1 As you face the printer, the system board door is on the right side. Open the system board door.

2 Use the following illustration to locate the appropriate connector.

Warning—Potential Damage: System board electronic components are easily damaged by static
electricity. Touch something metal on the printer before touching any system board electronic
components or connectors.

1 Ethernet connector

Note: The Ethernet port is a feature on network models only.

2 USB port

3 Parallel connector

4 Memory card connector

5 Optional card connector

6 Optional card connector
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Installing a memory card
CAUTION—SHOCK HAZARD: If you are accessing the system board or installing optional hardware or
memory devices sometime after setting up the printer, then turn the printer off, and unplug the power
cord from the wall outlet before continuing. If you have any other devices attached to the printer, then
turn them off as well, and unplug any cables going into the printer.

Warning—Potential Damage: System board electronic components are easily damaged by static electricity.
Touch something metal on the printer before touching any system board electronic components or
connectors.

An optional memory card can be purchased separately and attached to the system board. To install the memory
card:

1 Access the system board.

2 Unpack the memory card.

Note: Avoid touching the connection points along the edge of the card.

3 Align the memory card with its connector on the system board. Push the latches on the connector open if
they are not open already.
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4 Push the memory card into the connector until the latches snap into place.

5 Close the system board door.

Installing a flash memory or firmware card
The system board has two connections for an optional flash memory or firmware card. Only one of each may
be installed, but the connectors are interchangeable.

CAUTION—POTENTIAL INJURY: If you are installing internal options, memory cards, flash memory, or a
firmware card after setting up the printer, turn the printer off and unplug it from the wall outlet before
continuing. If you have other devices attached to the printer, then turn them off as well and unplug any
cables going to the printer.

Warning—Potential Damage: System board electronic components are easily damaged by static electricity.
Touch something metal on the printer before touching any system board electronic components or
connectors.

1 Open the system board door.
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2 Unpack the card.

Note: Avoid touching the connection points along the edge of the card.

3 Holding the card by its sides, align the card with the connector on the system board.

4 Push the card firmly into place.

Notes:

• The entire length of the connector on the card must touch and be flush against the system board.

• Be careful not to damage the connectors.

5 Close the system board door.

Installing hardware options

Installing a 250‑ or 550‑sheet drawer
The printer supports one optional drawer; you can install a 250‑ or 550‑sheet drawer.
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CAUTION—SHOCK HAZARD: If you are installing an optional drawer after setting up the printer, then
turn the printer off and unplug the power cord from the wall outlet before continuing

1 Unpack the drawer, and then remove any packing material from the outside of the drawer.

2 Remove the tray from the support unit.

1 Support unit

2 Tray

3 Remove any packing material and tape from inside the tray.

4 Insert the tray into the support unit.

5 Place the drawer in the location chosen for the printer.
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6 Align the printer with the drawer, and then lower the printer into place.

Attaching cables
1 Connect the printer to a computer or a network.

• For a local connection, use a USB or parallel cable.

• For a network connection, use an Ethernet cable.

2 Connect the power cord to the printer first and then to a wall outlet.
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1 Ethernet port

Note: The Ethernet port is a feature on network models only.

2 USB port

3 Parallel port

4 Printer power cord socket

Installing printer software
A printer driver is software that lets the computer communicate with the printer. The printer software is typically
installed during the initial printer setup. If you need to install the software after setup, follow these instructions:

For Windows users

1 Close all open software programs.

2 Insert the Software and Documentation CD.

3 From the main installation dialog, click Install.

4 Follow the instructions on the screen.

For Macintosh users

1 Close all open software applications.

2 Insert the Software and Documentation CD.

3 From the Finder desktop, double-click the printer CD icon that automatically appears.

Additional printer setup 23



4 Double-click the Install icon.

5 Follow the instructions on the screen.

Using the World Wide Web

1 Go to the Lexmark Web site at www.lexmark.com.

2 From the Drivers & Downloads menu, click Driver Finder.

3 Select your printer, and then select your operating system.

4 Download the driver and install the printer software.

Verifying printer setup

Printing a menu settings page
Print a menu settings page to review the current menu settings and to verify printer options are installed
correctly.

Note: If you have not made any menu item settings changes yet, then the menu settings page lists all the
factory default settings. Once you select and save other settings from the menus, they replace the factory
default settings as user default settings. A user default setting remains in effect until you access the menu
again, choose another value, and save it. To restore the factory default settings, see “Restoring the factory
default settings” on page 110.

1 Make sure the printer is on and Ready appears.

2 From the printer control panel, press .

3 Press the arrow buttons until Reports appears, and then press .

4 Press the arrow buttons until Menu Settings Page appears, and then press .

After the menu settings page prints, Ready appears.

Printing a network setup page
If the printer is attached to a network, print a network setup page to verify the network connection. This page
also provides important information that aids network printing configuration.

1 Make sure the printer is on and Ready appears.

2 From the printer control panel, press .

3 Press the arrow buttons until Reports appears, and then press .

Additional printer setup 24
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4 Press the arrow buttons until Network Setup Page appears, and then press .

After the network setup page prints, Ready appears.

5 Check the first section on the network setup page, and confirm that Status is “Connected.”

If Status is “Not Connected,” the LAN drop may not be active, or the network cable may be malfunctioning.
Consult a system support person for a solution, and then print another network setup page.
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Loading paper and specialty media
This section explains how to load the 250- and 550-sheet trays and the multipurpose feeder. It also includes
information about paper orientation, setting the Paper Size and Paper Type, and linking and unlinking trays.

Setting the Paper Size and Paper Type
After you set the Paper Size and Paper Type to the correct settings for the size and type used in the trays, then
any trays containing the same size and type are automatically linked by the printer.

Note: If the size of the paper being loaded now is the same size as the previously loaded paper, do not
change the Paper Size setting.

1 Make sure the printer is on and Ready appears.

2 From the printer control panel, press .

Paper Menu appears.

3 Press .

4 Press the arrow buttons until Size/Type appears, and then press .

Select Source appears.

5 Press the arrow buttons until the correct source appears, and then press .

Size appears under the source name.

6 Press .

7 Press the arrow buttons until the correct size appears, and then press .

Submitting Changes appears, followed by Size.

8 Press the arrow buttons until Type appears, and then press .

9 Press the arrow buttons until the correct type appears, and then press .

Submitting Changes appears, followed by Type.

Configuring Universal paper settings
The Universal Paper Size is a user‑defined setting that lets you print on paper sizes that are not preset in the
printer menus. Set the Paper Size for the specified tray to Universal when the size you want is not available
from the Paper Size menu. Then, specify all of the following Universal size settings for your paper:

• Units of measure (inches or millimeters)

• Portrait Height and Portrait Width

• Feed Direction

Note: The smallest supported Universal size is 76.2 x 127 mm (3 x 5 in.); the largest is 216 x 356 mm
(8.5 x 14 in.).
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Specify a unit of measurement

1 Make sure the printer is on and Ready appears.

2 From the printer control panel, press .

Paper Menu appears.

3 Press .

4 Press the arrow buttons until Universal Setup appears, and then press .

5 Press the arrow buttons until Units of Measure appears, and then press .

6 Press the arrow buttons until the correct unit of measure appears, and then press .

Submitting Changes appears, followed by the Universal Setup menu.

Specify the paper height and width

Defining a specific height and width measurement for the Universal paper size (in the portrait orientation) allows
the printer to support the size, including support for standard features such as duplex printing and printing
multiple pages on one sheet.

Note: Select Portrait Height to adjust the paper height setting or Paper Width to adjust the paper
width setting, or adjust both. Instructions to adjust both follow.

1 From the Universal Setup menu, press the arrow buttons until Portrait Width appears, and then press

.

2 Press the left arrow button to decrease the setting or the right arrow button to increase the setting, and

then press .

Submitting Changes appears, followed by the Universal Setup menu.

3 From the Universal Setup menu, press the arrow buttons until Portrait Height appears, and then press

.

4 Press the left arrow button to decrease the setting or the right arrow button to increase the setting, and

then press .

Submitting Changes appears, followed by the Universal Setup menu.

5 Press and release 

until Ready appears.
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Specify a feed direction

Short Edge is the factory default setting for feed direction for Universal paper settings. The Feed Direction
menu will not appear from the Universal Setup menu unless Long Edge is an available setting. If necessary,
specify whether the short or long edge of the paper will enter the printer first.

1 From the Universal Setup menu, press the arrow buttons until Feed Direction appears, and then press

.

2 Press the arrow buttons until Short Edge or Long Edge appears, and then press .

Loading the standard 250‑sheet tray
The printer has two trays to select from: the standard tray (Tray 1), also known as the 250‑sheet tray, and either
the optional 250‑sheet tray or the optional 550‑sheet tray (Tray 2). Only one optional drawer (which includes
an optional tray) may be attached to the printer at one time.

Notes:

• Proper paper loading prevents jams and facilitates trouble‑free printing.

• Do not remove trays while a job prints or while Busy appears on the display. Doing so may cause a jam.

1 Pull the tray completely out.

2 Squeeze the width guide tabs on the right guide as shown, and slide the width guides to the sides of the
tray. Notice that the two width guides move in unison when you move just the right width guide.

Loading paper and specialty media 28



3 Squeeze the length guide tabs together as shown, and slide the length guide to the correct position for the
paper size being loaded.

If you are loading a longer size of paper like A4 or legal, squeeze the length guide tab and slide the length
guide backwards to the position for the length of paper you are loading. The tray extends backwards as
shown.

If you are loading A6‑size paper:

a Squeeze the length guide tab shown as follows, and slide the length guide toward the center of the tray
to the A5 size position.

b Raise the A6 backstop.

Note: The standard tray only accommodates 150 sheets of A6 paper. Notice the maximum fill line on the A6
backstop which indicates the maximum height for loading A6 paper. Do not try to overload the tray.
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Notes:

• Notice the size indicators on the bottom of the tray. Use these indicators to help position the guide.

• For setup, load letter‑ or A4‑size paper based on the standard size for your country or region.

4 Flex the sheets back and forth to loosen them, and then fan them. Do not fold or crease the paper. Straighten
the edges on a level surface.

5 Load the paper stack toward the back of the tray as shown with the recommended print side facedown.

Note: Notice the maximum fill line on the side of the width guide which indicates the maximum height for
loading paper. Do not try to overload the tray. Do not load A6 paper to the maximum fill line; the tray only
holds 150 sheets of A6 paper.
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1 Maximum fill line

When loading letterhead, place the top edge of the sheet toward the front of the tray. Load the letterhead
with the design placed facedown.

6 Squeeze the width guide tabs on the right guide, and slide the width guides to lightly touch the side of the
stack.

Loading paper and specialty media 31



7 Insert the tray.

8 If a different type of paper was loaded than the type previously loaded in the tray, change the Paper Type
setting for the tray from the printer control panel. For more information, see “Setting the Paper Size and
Paper Type” on page 26.

Note: The difference between the standard 250‑sheet tray and the optional 250‑ and 550‑sheet trays is that
the standard tray accommodates A6‑size paper, so the width guides slide farther to the center of the tray.
You also need to adjust the length guide specifically created for A6.

Loading the optional 250‑ or 550‑sheet tray
Only one optional drawer, which includes either a 250‑ or 550‑sheet tray, may be attached to the printer at a
time. Regardless of the number of sheets in the optional tray, it is referred to as Tray 2.

1 Pull the tray completely out.

2 See “Loading the standard 250‑sheet tray” on page 28 to complete the steps for loading a tray. An optional
tray is loaded in the same way that the standard tray is loaded.
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3 Insert the tray.

Using the multipurpose feeder
You may want to use the multipurpose feeder when you print on different sizes and types of papers or specialty
media, such as card stock, transparencies, paper labels, and envelopes. You may also want to use the
multipurpose feeder for single‑page print jobs on letterhead or on other specialty media you do not keep in a
tray.

Opening the multipurpose feeder

1 Grasp the handle, and pull the multipurpose feeder door down.
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2 Grasp the raised handle, and pull the extension forward.

3 Grasp the handle, and pull the extension so it flips forward.

4 Guide the extension down gently so the multipurpose feeder is extended fully and open.
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Loading the multipurpose feeder

1 Squeeze the tab located on the right width guide, and move the guides out fully.

2 Prepare the paper or specialty media for loading.

• Flex sheets of paper or paper labels back and forth to loosen them, and then fan them. Do not fold or
crease the paper or labels. Straighten the edges on a level surface.

• Hold transparencies by the edges, and then fan them. Straighten the edges on a level surface.

Note: Avoid touching the print side of the transparencies. Be careful not to scratch them.

• Flex a stack of envelopes back and forth to loosen them, and then fan them. Straighten the edges on a
level surface.
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Note: Fanning prevents the edges of envelopes from sticking together. It also helps them feed
properly to avoid jams. Do not fold or crease envelopes.

3 Load the paper or specialty media.

Notes:

• Do not force any paper into the multipurpose feeder. Overfilling may cause jams.

• Do not exceed the maximum stack height by forcing paper or specialty media under the stack height
limiters which are located on the guides.

• Load paper, transparencies, and card stock with the recommended print side faceup and the top edge
entering the printer first. For more information on loading transparencies, see the packaging the
transparencies came in.
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• Load letterhead with the logo faceup and the top edge entering the printer first.

• Load envelopes with the flap side down and the stamp location in the position shown. The stamp and
address are shown to illustrate the proper orientation for loading envelopes.

Warning—Potential Damage: Never use envelopes with stamps, clasps, snaps, windows, coated
linings, or self‑stick adhesives. These envelopes may severely damage the printer.

4 Squeeze the tab located on the right width guide to adjust the guides to lightly touch the sides of the stack.
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5 Slide the paper gently into the multipurpose feeder until it comes to a stop. Paper should lie flat in the
multipurpose feeder. Make sure the paper fits loosely in the multipurpose feeder and is not bent or wrinkled.

6 From the printer control panel, set the Paper Size and Paper Type.

Paper capacities
The capacities of the trays and the multipurpose feeder are based on 75 g/m2 (20 lb) paper.

Load up to Notes

Tray 1
250 sheets of paper
150 sheets of A6‑size paper
50 paper labels
50 transparencies

Note: Vinyl, pharmacy, or dual‑sided labels are not
supported. Use paper labels only. Single‑sided paper labels
designed for laser printers are supported for occasional use.
It is recommended to print no more than 20 pages of paper
labels per month.

Tray 2
250 or 550 sheets of paper
50 paper labels

Note: Only one optional drawer may be installed on the
printer at a time. The maximum amount of paper that can be
loaded depends on whether you have an optional 250‑ or
550‑sheet tray.

Multipurpose feeder
50 sheets of paper
15 paper labels
10 transparencies
10 sheets of card stock
7 envelopes

Note: Feed paper into the multipurpose feeder only to the
point where its leading edge can contact the paper guides.
Do not force the paper into the feeder.

Linking and unlinking trays

Linking trays
Tray linking is useful for large print jobs or multiple copies. When one linked tray is empty, paper feeds from
the next linked tray. When the Size and Type settings are the same for any trays, the trays are automatically
linked. The Size and Type settings for all trays must be set from the Paper menu.
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Unlinking trays
Unlinked trays have settings that are not the same as the settings of any other tray. To unlink a tray using the
Paper menu, change the Paper Type and Paper Size settings so that they do not match the settings of any other
tray.

1 From the Paper menu, make sure the Type setting (for example, Plain Paper, letterhead, Custom Type <x>)
for the tray you want to unlink does not match the Type setting of any other tray.

If the name that best describes your paper is used by linked trays, assign a different Paper Type name to
the tray, such as Custom Type <x>, or assign your own custom name.

2 Make sure the Size setting (for example, letter, A4, statement) for the tray you want to unlink does not match
the Size setting of any other tray.

Note: Paper Size settings are not automatic; they must be set manually from the Paper menu.

Warning—Potential Damage: Do not assign a Paper Type name that does not accurately describe the type
of paper loaded in the tray. The temperature of the fuser varies according to the specified Paper Type. Paper
may not be properly processed if an inaccurate Paper Type is selected.

Assigning a Custom Type <x> name
Assign a Custom Type <x> name to a tray to link or unlink it. Associate the same Custom Type <x> name to each
tray that you want to link. Only trays with the same custom names assigned will link.

1 Make sure the printer is on and Ready appears.

2 From the printer control panel, press .

3 Press the arrow buttons until Paper Menu appears, and then press .

4 Press the arrow buttons until Size/Type appears, and then press .

5 Press the arrow buttons until Select Source appears, and then press .

6 Press the arrow buttons until the name of the tray you want appears, and then press .

The Set Size menu item appears.

7 Press the arrow buttons until the size you want appears, and then press .

The Paper Menu appears.

8 Press the arrow buttons until Custom Types appears, and then press .

9 Press the arrow buttons until Custom Type <x> or another custom name appears, and then press .

Submitting Changes appears, followed by Paper Menu.

10 Verify that the correct Paper Type is associated with the custom name.

Note: Plain Paper is the factory default Paper Type associated with all Custom Type <x> names and
user‑defined custom names.

11 Press and release  until Ready appears.
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Changing a Custom Type <x> name
If the printer is on a network, you can use the Embedded Web Server to define a name other than Custom Type
<x> for each of the custom paper types that are loaded. When a Custom Type <x> name is changed, the menus
display the new name instead of Custom Type <x>.

To change a Custom Type <x> name:

1 Type the printer IP address into the address field of your Web browser.

Note: If you do not know the IP address of the printer, print a network setup page and locate the address
in the TCP/IP section.

2 Click Settings.

3 Click Paper Menu.

4 Click Custom Name.

5 Type a name for the paper type in a Custom Name <x> box.

Note: This custom name will replace a custom type <x> name under the Custom Types and Paper Size
and Type menus.

6 Click Submit.

7 Click Custom Types.

Custom Types appears, followed by your custom name.

8 Select a Paper Type setting from the pick list next to your custom name.

9 Click Submit.
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Paper and specialty media guidelines

Paper guidelines
Selecting the correct paper or specialty media reduces printing problems. For the best print quality, try a sample
of the paper or specialty media before buying large quantities.

Paper characteristics
The following paper characteristics affect print quality and reliability. Consider these characteristics when
evaluating new paper stock.

Weight

The printer trays can automatically feed paper weights up to 90 g/m2 (24 lb bond) grain long paper. The
multipurpose feeder can automatically feed paper weights up to 163 g/m2 (43 lb bond) grain long. Paper lighter
than 60 g/m2 (16 lb) might not be stiff enough to feed properly, causing jams. For best performance, use
75 g/m2 (20 lb bond) grain long paper. For paper smaller than 182 x 257 mm (7.2 x 10.1 in.), we recommend
90 g/m2 (24 lb) or heavier paper.

Note: Duplex printing is supported only for 60–90 g/m2 (16–24 lb bond) paper.

Curl

Curl is the tendency for paper to curl at its edges. Excessive curl can cause paper feeding problems. Curl can
occur after the paper passes through the printer, where it is exposed to high temperatures. Storing paper
unwrapped in hot, humid, cold, or dry conditions, even in the trays, can contribute to paper curling prior to
printing and can cause feeding problems.

Smoothness

Paper smoothness directly affects print quality. If paper is too rough, toner cannot fuse to it properly. If paper
is too smooth, it can cause paper feeding or print quality issues. Always use paper between 100–300 Sheffield
points; smoothness between 150–250 Sheffield points produces the best print quality.

Moisture content

The amount of moisture in paper affects both print quality and the ability of the printer to feed the paper correctly.
Leave paper in its original wrapper until it is time to use it. This limits the exposure of paper to moisture changes
that can degrade its performance.

Condition paper before printing by storing it in its original wrapper in the same environment as the printer for
24 to 48 hours before printing. Extend the time several days if the storage or transportation environment is very
different from the printer environment. Thick paper may also require a longer conditioning period.

Grain direction

Grain refers to the alignment of the paper fibers in a sheet of paper. Grain is either grain long, running the length
of the paper, or grain short, running the width of the paper.

For 60–90 g/m2 (16–24 lb bond) paper, grain long paper is recommended.
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Fiber content

Most high‑quality xerographic paper is made from 100% chemically treated pulped wood. This content provides
the paper with a high degree of stability resulting in fewer paper feeding problems and better print quality.
Paper containing fibers such as cotton can negatively affect paper handling.

Unacceptable paper
The following paper types are not recommended for use with the printer:

• Chemically treated papers used to make copies without carbon paper, also known as carbonless papers,
carbonless copy paper (CCP), or no carbon required (NCR) paper

• Preprinted papers with chemicals that may contaminate the printer

• Preprinted papers that can be affected by the temperature in the printer fuser

• Preprinted papers that require a registration (the precise print location on the page) greater than ±2.3 mm
(±0.9 in.), such as optical character recognition (OCR) forms

In some cases, registration can be adjusted with a software application to successfully print on these forms.

• Coated papers (erasable bond), synthetic papers, thermal papers

• Rough‑edged, rough or heavily textured surface papers, or curled papers

• Recycled papers that fail EN12281:2002 (European)

• Paper weighing less than 60 g/m2 (16 lb)

• Multiple‑part forms or documents

Selecting paper
Using appropriate paper prevents jams and helps ensure trouble‑free printing.

To help avoid jams and poor print quality:

• Always use new, undamaged paper.

• Before loading paper, know the recommended print side. This information is usually indicated on the
package.

• Do not use paper, paper labels, or card stock that has been cut or trimmed by hand.

• Do not mix sizes, types, or weights in the same source; mixing results in jams.

• Do not use coated papers unless they are specifically designed for electrophotographic printing.

Selecting preprinted forms and letterhead
Use these guidelines when selecting preprinted forms and letterhead:

• Use grain long for 60 to 90 g/m2 weight paper.

• Use only forms and letterhead printed using an offset lithographic or engraved printing process.

• Avoid papers with rough or heavily textured surfaces.

Use papers printed with heat‑resistant inks designed for use in xerographic copiers. The ink must be able to
withstand temperatures up to 230°C (446°F) without melting or releasing hazardous emissions. Use inks that
are not affected by the resin in toner. Inks that are oxidation‑set or oil‑based generally meet these requirements;
latex inks might not. When in doubt, contact the paper supplier.
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Preprinted papers such as letterhead must be able to withstand temperatures up to 230°C (446°F) without
melting or releasing hazardous emissions.

Using recycled paper and other office papers
As an environmentally conscious company, Lexmark supports the use of recycled office paper produced
specifically for use in laser (electrophotographic) printers. In 1998, Lexmark presented to the US government
a study demonstrating that recycled paper produced by major mills in the US fed as well as non-recycled paper.
However, no blanket statement can be made that all recycled paper will feed well.

Lexmark consistently tests its printers with recycled paper (20–100% post-consumer waste) and a variety of
test paper from around the world, using chamber tests for different temperature and humidity conditions.
Lexmark has found no reason to discourage the use of today's recycled office papers, but generally the following
property guidelines apply to recycled paper.

• Low moisture content (4–5%)

• Suitable smoothness (100–200 Sheffield units, or 140–350 Bendtsen units, European)

Note: Some much smoother papers (such as premium 24 lb laser papers, 50–90 Sheffield units) and
much rougher papers (such as premium cotton papers, 200–300 Sheffield units) have been engineered
to work very well in laser printers, despite surface texture. Before using these types of paper, consult your
paper supplier.

• Suitable sheet-to-sheet coefficient of friction (0.4–0.6)

• Sufficient bending resistance in the direction of feed

Recycled paper, paper of lower weight (<60 g/m2 [16 lb bond]) and/or lower caliper (<3.8 mils [0.1 mm]), and
paper that is cut grain-short for portrait (or short-edge) fed printers may have lower bending resistance than is
required for reliable paper feeding. Before using these types of paper for laser (electrophotographic) printing,
consult your paper supplier. Remember that these are general guidelines only and that paper meeting these
guidelines may still cause paper feeding problems in any laser printer (for example, if the paper curls excessively
under normal printing conditions).

Storing paper
Use these paper storage guidelines to help avoid jams and uneven print quality:

• For best results, store paper where the temperature is 21°C (70°F) and the relative humidity is 40%. Most
label manufacturers recommend printing in a temperature range of 18 to 24°C (65 to 75°F) with relative
humidity between 40 and 60%.

• Store paper in cartons when possible, on a pallet or shelf, rather than on the floor.

• Store individual packages on a flat surface.

• Do not store anything on top of individual paper packages.
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Supported paper sizes, types, and weights
The following tables provide information on standard and optional paper sources and the types of paper they
support.

Note: For an unlisted paper size, select the closest larger listed size.

For information on card stock and labels, see the Card Stock & Label Guide.

Paper types and weights supported by the printer
The printer engine and the duplex path support 60–90 g/m2 (16–24 lb) paper weights. The multipurpose feeder
supports 60–163 g/m2 (16–43 lb) paper weights.

Paper type Standard
250‑sheet tray

Optional 250‑ or
550‑sheet tray

Multipurpose feeder Duplex path

Paper

• Plain

• Light

• Heavy

• Rough/Cotton

• Recycled

• Custom

Bond

Letterhead

Preprinted

Colored Paper

Card stock X X X

Glossy paper X X X X

Paper labels1 X

Transparencies X X

Envelopes (smooth)2 X X X

1 Single‑sided paper labels designed for laser printers are supported for occasional use. It is recommended to print
no more than 20 pages of paper labels a month. Vinyl, pharmacy, and dual‑sided labels are not supported.
2 Use envelopes that lie flat when individually placed on a table facedown.
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Paper sizes supported by the printer

Paper size Dimensions Standard
250‑sheet tray

Optional 250‑
or 550‑sheet
tray

Multipurpose
feeder

Duplex path

A4 210 x 297 mm
(8.3 x 11.7 in.)

A5 148 x 210 mm
(5.8 x 8.3 in.)

X

A61 105 x 148 mm
(4.1 x 5.8 in.)

X X

Executive 184 x 267 mm
(7.3 x 10.5 in.)

X

Folio 216 x 330 mm
(8.5 x 13 in.)

JIS B5 182 x 257 mm
(7.2 x 10.1 in.)

X

Legal 216 x 356 mm
(8.5 x 14 in.)

Letter 216 x 279 mm
(8.5 x 11 in.)

Oficio (Mexico) 216 x 340 mm
(8.5 x 13.4 in.)

Statement 140 x 216 mm
(5.5 x 8.5 in.)

X

Universal2 76.2 x 127 mm
(3 x 5 in.) up to
216 x 356 mm
(8.5 x 14 in.)

X3

B5 Envelope 176 x 250 mm
(6.9 x 9.8 in.)

X X X

C5 Envelope 162 x 229 mm
(6.4 x 9 in.)

X X X

DL Envelope 110 x 220 mm
(4.3 x 8.7 in.)

X X X

7 3/4 Envelope
(Monarch)

98 x 191 mm
(3.9 x 7.5 in.)

X X X

9 Envelope 98 x 225 mm
(3.9 x 8.9 in.)

X X X

1 A6 is supported only for grain long papers.
2 If a paper size you want to use is not listed, configure a Universal paper size. For more information, see “Configuring
Universal paper settings” on page 26.
3 Universal paper size has limited support in the duplex path for paper sizes 210 x 279 mm (8.3 x 11 in.) or larger.
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Paper size Dimensions Standard
250‑sheet tray

Optional 250‑
or 550‑sheet
tray

Multipurpose
feeder

Duplex path

10 Envelope 105 x 241 mm
(4.1 x 9.5 in.)

X X X

Other Envelope 229 x 356 mm
(9 x 14 in.)

X X X

1 A6 is supported only for grain long papers.
2 If a paper size you want to use is not listed, configure a Universal paper size. For more information, see “Configuring
Universal paper settings” on page 26.
3 Universal paper size has limited support in the duplex path for paper sizes 210 x 279 mm (8.3 x 11 in.) or larger.
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Printing
This chapter covers printing, printer reports, and job cancelation. Selection and handling of paper and specialty
media can affect how reliably documents print. For more information, see “Avoiding jams” on page 54 and
“Storing paper” on page 43.

Printing a document
1 Load paper into a tray or feeder.

2 From the Paper menu, set the Paper Type and Paper Size based on the paper that is loaded.

3 Do one of the following:

For Windows users
a With a document open, click File > Print.

b Click Properties, Preferences, Options, or Setup.

c From the Form Source list box, select the source containing the paper you loaded.

d From the Form Type list box, select the paper type.

e From the Form Size list box, select the paper size.

f Click OK, and then click Print.

For Macintosh users

In Mac OS X:

a Customize the settings as needed in the Page Setup dialog.
1 With a document open, choose File > Page Setup.
2 From the Paper Size pop‑up menu, choose a paper size or create a custom size to match the loaded

paper.
3 Click OK.

b Customize the settings as needed in the Print dialog:
1 With a document open, click File > Print.

If necessary, click the disclosure triangle to see more options.
2 From the print options or Copies & Pages pop‑up menu, choose Printer Features.
3 From the Feature Sets pop‑up menu, choose Paper.
4 From the Paper type pop‑up menu, choose a paper type.
5 Click Print.

In Mac OS 9:

a Customize the settings as needed in the Page Setup dialog:
1 With a document open, choose File > Page Setup.
2 From the Paper pop‑up menu, choose a paper size or create a custom size to match the loaded

paper.
3 Click OK.
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b Customize the settings as needed in the Print dialog:
1 With a document open, choose File > Print.
2 Select a Paper Source option, and then choose the tray loaded with the appropriate paper.
3 Click Print.

Printing specialty documents

Tips on using letterhead
Page orientation is important when printing on letterhead. Use the following table to determine which direction
to load the letterhead:

Source or process Print side Paper orientation

• Standard
250‑sheet tray

• Optional
250‑sheet tray

• Optional
550‑sheet tray

Printed letterhead
design is placed
facedown.

The top edge of the sheet with the logo is placed at the front of
the tray.

Duplex (two‑sided)
printing from trays

Printed letterhead
design is placed
faceup.

The top edge of the sheet with the logo is placed at the front of
the tray.

Note: Check with the manufacturer or vendor to determine whether the chosen preprinted letterhead is
acceptable for laser printers.
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Source or process Print side Paper orientation

Multipurpose feeder
(simplex printing)

Preprinted letterhead
design is placed
faceup.

The top edge of the sheet with the logo should enter the
multipurpose feeder first.

Multipurpose feeder
(duplex printing)

Preprinted letterhead
design is placed
facedown.

The top edge of the sheet with the logo should enter the
multipurpose feeder last.

Note: Check with the manufacturer or vendor to determine whether the chosen preprinted letterhead is
acceptable for laser printers.

Tips on using transparencies
Print samples on the transparencies being considered for use before buying large quantities.

When printing on transparencies:

• Feed transparencies from the standard 250‑sheet tray or the multipurpose feeder.

• Use transparencies designed specifically for laser printers. Check with the manufacturer or vendor to ensure
transparencies are able to withstand temperatures up to 175°C (350°F) without melting, discoloring,
offsetting, or releasing hazardous emissions.

Note: Transparencies can be printed at a temperature up to 180°C (356°F) if Transparency Weight is set to
Heavy and Transparency Texture is set to Rough. Select these settings using the Embedded Web Server,
or from the printer control panel Paper menu.

• To prevent print quality problems, avoid getting fingerprints on the transparencies.

• Before loading transparencies, fan the stack to prevent sheets from sticking together.

• We recommend Lexmark part number 70X7240 for letter‑size transparencies and Lexmark part number
12A5010 for A4‑size transparencies.

Tips on using envelopes
Print samples on the envelopes being considered for use before buying large quantities.
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When printing on envelopes:

• Use envelopes designed specifically for laser printers. Check with the manufacturer or vendor to ensure
the envelopes can withstand temperatures up to 210°C (410°F) without sealing, wrinkling, curling excessively,
or releasing hazardous emissions.

• For the best performance, use envelopes made from 90 g/m2 (24 lb bond) paper. Use up to 105 g/m2

(28 lb bond) weight for envelopes as long as the cotton content is 25% or less. All‑cotton envelopes must
not exceed 90 g/m2 (24 lb bond) weight.

• Use only new envelopes.

• To optimize performance and minimize jams, do not use envelopes that:

– Have excessive curl or twist

– Are stuck together or damaged in any way

– Have windows, holes, perforations, cutouts, or embossing

– Have metal clasps, string ties, or folding bars

– Have an interlocking design

– Have postage stamps attached

– Have any exposed adhesive when the flap is in the sealed or closed position

– Have bent corners

– Have rough, cockle, or laid finishes

• Adjust the width guides to fit the width of the envelopes.

Note: A combination of high humidity (over 60%) and the high printing temperature may wrinkle or seal
envelopes.

Tips on using labels
Print samples on the labels being considered for use before buying large quantities.

Note: Use only paper label sheets. Vinyl, pharmacy, and dual‑sided labels are not supported.

For detailed information on label printing, characteristics, and design, see the Card Stock & Label Guide
available on the Lexmark Web site at www.lexmark.com/publications.

When printing on labels:

• Use labels designed specifically for laser printers. Check with the manufacturer or vendor to verify that:

– The labels can withstand temperatures up to 210°C (410°F) without sealing, excessive curling, wrinkling,
or releasing hazardous emissions.

Note: Labels can be printed at a higher fusing temperature up to 220°C (428°F) if Label Weight is set
to Heavy. Select this setting using the Embedded Web Server, or from the printer control panel Paper
menu.

– Label adhesives, face sheet (printable stock), and topcoats can withstand up to 25 psi (172 kPa) pressure
without delaminating, oozing around the edges, or releasing hazardous fumes.

• Do not use labels with slick backing material.

• Use full label sheets. Partial sheets may cause labels to peel off during printing, resulting in a jam. Partial
sheets also contaminate the printer and the cartridge with adhesive, and could void the printer and cartridge
warranties.

• Do not use labels with exposed adhesive.

Printing 50

http://www.lexmark.com/publications


• Do not print within 1 mm (0.04 in.) of the edge of the label, of the perforations, or between die‑cuts of the
label.

• Be sure adhesive backing does not reach to the sheet edge. Zone coating of the adhesive at least 1 mm
(0.04 in.) away from edges is recommended. Adhesive material contaminates the printer and could void the
warranty.

• If zone coating of the adhesive is not possible, remove a 1.6 mm (0.06 in.) strip on the leading and driver
edge, and use a non‑oozing adhesive.

• Portrait orientation works best, especially when printing bar codes.

Tips on using card stock
Card stock is heavy, single‑ply specialty media. Many of its variable characteristics, such as moisture content,
thickness, and texture, can significantly impact print quality. Print samples on the card stock being considered
for use before buying large quantities.

When printing on card stock:

• Make sure the Paper Type is Card Stock.

• Select the appropriate Paper Texture setting.

• Be aware that preprinting, perforation, and creasing may significantly affect the print quality and cause jams
or other paper handling problems.

• Check with the manufacturer or vendor to ensure the card stock can withstand temperatures up to 210°C
(410°F) without releasing hazardous emissions.

• Do not use preprinted card stock manufactured with chemicals that may contaminate the printer. Preprinting
introduces semi‑liquid and volatile components into the printer.

• Use grain short card stock when possible.

Printing information pages
See “Printing a menu settings page” on page 24 and “Printing a network setup page” on page 24 for more
information on printing these pages.

Printing a font sample list
To print samples of the fonts currently available for your printer:

1 Make sure the printer is on and Ready appears.

2 From the printer control panel, press .

3 Press the arrow buttons until Reports appears, and then press .

4 Press the arrow buttons until Print Fonts appears, and then press .

5 Press the arrow buttons until PCL Fonts or PostScript Fonts appears, and then press .

After the font sample list prints, Ready appears.
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Printing a directory list
A directory list shows the resources stored in flash memory.

1 Make sure the printer is on and Ready appears.

2 From the printer control panel, press .

3 Press the arrow buttons until Reports appears, and then press .

4 Press the arrow buttons until Print Directory appears, and then press .

After the directory list prints, Ready appears.

Printing the print quality test pages
Print the print quality test pages to isolate print quality problems.

1 Turn the printer off.

2 Hold down  and  while turning the printer on.

3 Release the buttons when the clock appears, and wait for CONFIG MENU to appear.

4 Press the arrow buttons until Prt Quality Pgs appears, and then press .

The print quality test pages print.

5 Press the arrow buttons until Exit Config Menu appears, and then press .

Resetting the Printer appears briefly, followed by a clock, and then Ready appears.

Canceling a print job

Canceling a print job from the printer control panel
If the job is formatting or already printing, and Cancel a job appears:

1 Press the arrow buttons until Cancel appears.

A list of jobs appears.

2 Press the arrow buttons until the job you want to cancel appears, and then press .

Note: Once a print job is sent, to cancel a job, press . The Stopped screen appears. Press the arrow

buttons until Cancel a job appears, and then press .

Canceling a print job from the computer
To cancel a print job, do one of the following:
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For Windows users

In Windows Vista:

1 Click .

2 Click Control Panel.

3 Click Hardware and Sound.

4 Click Printers.

5 Double‑click the printer icon.

6 Select the job to cancel.

7 From the keyboard, press Delete.

In Windows XP:

1 Click Start.

2 From Printers and Faxes, double‑click the printer icon.

3 Select the job to cancel.

4 From the keyboard, press Delete.

From the Windows taskbar:

When you send a job to print, a small printer icon appears in the right corner of the taskbar.

1 Double‑click the printer icon.

A list of print jobs appears in the printer window.

2 Select a job to cancel.

3 From the keyboard, press Delete.

For Macintosh users

In Mac OS X version 10.5:

1 From the Apple menu, choose System Preferences.

2 Click Print & Fax, and then double‑click the printer icon.

3 From the printer window, select the job to cancel.

4 From the icon bar at the top of the window, click the Delete icon.

In Mac OS X version 10.4 and earlier:

1 From the Go menu, choose Applications.

2 Double‑click Utilities, and then double‑click Print Center or Printer Setup Utility.

3 Double‑click the printer icon.

4 From the printer window, select the job to cancel.

5 From the icon bar at the top of the window, click the Delete icon.
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Clearing jams
By carefully selecting papers and specialty media and loading it properly, you should be able to avoid most
jams. For more information, see “Avoiding jams” on page 54. If jams do occur, follow the steps outlined in this
chapter.

To resolve the jam messages, you must clear the entire paper path and press  to clear the message and
resume printing. The printer prints a new copy of the page that jammed if Jam Recovery is set to On or Auto;
however, the Auto setting does not guarantee the page will print.

Note: Jam recovery is set to Auto by default. When jam recovery is set to Auto, the memory that holds the
image of the page may be re‑used after the page is printed if the memory is needed for another use. This
can occur before the paper exits the printer. Therefore, a jammed page may or may not be reprinted,
depending on the overall memory usage in the printer.

Avoiding jams
The following hints can help you avoid jams:

• Use only recommended paper or specialty media. For more information, see “Supported paper sizes, types,
and weights” on page 44.

• Do not load too much paper. Make sure the stack height does not exceed the indicated maximum height.

• Do not load wrinkled, creased, damp, bent, or curled paper.

• Flex, fan, and straighten paper before loading it.

• Do not use paper that has been cut or trimmed by hand.

• Do not mix paper sizes, weights, or types in the same stack.

• Do not feed envelopes that:

– Have excessive curl or twist

– Have windows, holes, perforations, cutouts, or embossing

– Have metal clasps, string ties, or folding bars

– Have an interlocking design

– Have postage stamps attached

– Have any exposed adhesive when the flap is in the sealed or closed position

– Have bent corners

– Have rough, cockle, or laid finishes

– Are stuck together or damaged in any way

• Store the paper in an appropriate environment.

• Do not remove trays while the printer is printing.

• Do not load the multipurpose feeder while the printer is printing. Load the multipurpose feeder prior to
printing, or wait for a prompt to load it.

• Push all trays in firmly after loading paper.

• Make sure the guides in the trays are properly positioned and are not pressing too tightly against the paper.

• Make sure all sizes and types are set correctly in the printer control panel menu.

• Make sure all printer cables are attached correctly. For more information, see the setup documentation.
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Identifying jams in the paper path
The following illustration shows the path that paper travels through the printer. The path varies depending on
the input source (tray or feeder) and depending on whether a duplex (two‑sided) print job is being sent.

When a jam occurs, a jam message appears, indicating the region of the jam or the number of jammed sheets.
The three‑digit jam prefix numbers are given in the following illustration to show where each jam occurs.

Understanding jam messages and locations
Note: To resolve any message, all paper or specialty media must be cleared from the entire paper path.

Open doors and covers, and remove trays to access jam locations. The following illustration and table indicate
these locations. See “Jam message numbers and how to access each jam” on page 0  for a list of jam numbers
and instructions for how to access each jam.
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1 Standard exit bin

2 Front door

3 Multipurpose feeder door

4 Tray 1

5 Optional 250‑ or 550‑sheet tray (Tray 2)

6 Rear door

Jam number To access the jam

200 Try one or more of the following:

• Remove Tray 1.

• Open the front door, and then remove the photoconductor kit.

201 Open the front door, and then remove the photoconductor kit.

202 Open the front door, and then open the rear door.

231 Open the front door, and then open the rear door.

233 Remove Tray 1, and then depress the lever.

Note: For alternative access to the jam, open the front door, and then open the rear door.

234 Try one or more of the following:

• Open the front door, and then open the rear door.

• Remove Tray 1, and then depress the lever.

235 Remove the jam from the standard exit bin.
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Jam number To access the jam

242 Remove Tray 2.

251 Open the multipurpose feeder door.

200 paper jam
1 Remove the tray from the printer.

2 Remove the jam if you see it here.

3 If you do not see it, open the front door, and then remove the photoconductor kit and toner cartridge (unit).

Note: When the photoconductor kit and toner cartridge are together, they are called a unit.
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4 Lift the flap in front of the printer, and remove any jammed sheets.

5 Align and insert the unit.

6 Close the front door.

7 Insert the tray.

8 Press .

201 paper jam
CAUTION—HOT SURFACE: The fuser and the inside of the printer near the fuser may be hot. To reduce
the risk of injury from a hot component, allow the surface to cool before removing paper from this area.

1 Open the front door, and then remove the unit.
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2 Lift the flap in front of the printer, and then remove any jammed sheets.

3 Align and insert the unit.

4 Close the front door.

5 Press .

202 paper jam
CAUTION—HOT SURFACE: The fuser and the inside of the printer near the fuser may be hot. To reduce
the risk of injury from a hot component, allow the surface to cool before removing paper from this area.

1 Open the front door, and then remove the unit.

2 Lift the flap in front of the printer, and then remove any jammed sheets.
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3 Open the rear door.

4 Remove the jam.

5 Close the rear door.

6 Close the front door.

7 Press .
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231 paper jam
CAUTION—HOT SURFACE: The fuser and the inside of the printer near the fuser may be hot. To reduce
the risk of injury from a hot component, allow the surface to cool before removing paper from this area.

1 Open the front door.

2 Open the rear door.

3 Remove the jam.

4 Close the rear door.

5 Close the front door.

6 Press .
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233 paper jam
1 Remove the tray from the printer.

2 Locate the lever shown. Pull the level down to release the jam.

3 Pull the jammed sheets from the duplex area.

4 Insert the tray.

5 Press .

If this does not clear the jam, complete the steps in “231 paper jam” on page 61.

234 paper jam
A single jam or multiple jams are in the duplex area of the printer when the printer is turned on. To locate and
remove the jammed sheets, complete all the steps in:

• “231 paper jam” on page 61

• “233 paper jam” on page 62
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235 paper jam
A duplex print job was sent to the printer using a size of paper not supported for duplex printing. A sheet is
jammed in the standard exit bin.

1 To remove the jam, gently pull the jammed sheet out of the standard exit bin.

2 Press .

242 paper jam
1 Remove the optional tray from the printer.
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2 Remove the jam.

3 Insert the optional tray.

4 Press .

251 paper jam
A sheet of paper or specialty media failed to feed completely from the multipurpose feeder. Part of it may be
still visible. If it is visible, gently pull the jammed sheet from the front of the multipurpose feeder.
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If the sheet is not visible, complete the following steps:

1 Open the front door, and then remove the unit.

2 Lift the flap at the front of the printer, and then remove any jammed sheets of paper that are short lengths
of paper.

3 Align and insert the unit.

4 Close the front door.

5 Press .
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Understanding printer menus

Menus list
A number of menus are available to make it easy for you to change printer settings:

Paper Menu Reports

Default Source

Paper Size/Type

Configure MP

Paper Texture

Paper Weight

Paper Loading

Custom Types

Universal Setup

Menu Settings Page

Device Statistics

Network Setup Page

Network <x> Setup Page

Print Fonts

Print Directory

Asset Report

Settings Network/Ports

General Settings

Setup Menu

Finishing Menu

Quality Menu

Utilities Menu

PostScript Menu

PCL Emul Menu

Network Card

TCP/IP

IPv6

Network Menu*

Apple Talk

USB Menu

Parallel Menu

* Depending on the printer setup, this menu item appears as Standard Network, Wireless Network, or Network <x>.
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Paper menu

Default Source menu

Menu item Description

Default Source
Tray <x>
MP Feeder
Manual Paper
Manual Env

Sets a default paper source for all print jobs

Notes:

• From the Paper menu, Configure MP must be set to Cassette in
order for MP Feeder to appear as a menu setting.

• Tray 1 (standard tray) is the factory default setting.

• Only an installed paper source will appear as a menu setting.

• A paper source selected by a print job will override the Default
Source setting for the duration of the print job.

• If the same size and type of paper are in two trays and the Paper
Size and Paper Type settings match, the trays are automatically
linked. When one tray is empty, the job prints using the linked tray.

Size/Type menu

Menu item Description

Select Source menu
Tray 1
Tray 2
MP Feeder
Manual Paper
Manual Env

Notes:

• These menus let you specify the installed paper size and type in
the selected tray or manual feeder.

• Only installed trays and feeders are listed in this menu.

Set Size menu for Tray 1 or Tray 2
A4
A5
A6
JIS B5
Executive
Folio
Legal
Letter
Oficio (Mexico)
Statement
Universal

Lets you specify the paper size loaded in each tray

Notes:

• Letter is the US factory default setting. A4 is the international
factory default setting.

• If the same size and type of paper are in two trays and the Paper
Size and Paper Type settings match, then the trays are
automatically linked. When one tray is empty, the job prints using
paper from the linked tray.

• The A6 paper size is supported only in Tray 1.
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Menu item Description

Set Size menu for Manual Paper
A4
A5
Executive
Folio
JIS B5
Legal
Letter
Oficio (Mexico)
Statement
Universal

Lets you specify the size of the paper being loaded in the manual feeder

Note: Letter is the US factory default setting. A4 is the international
factory default setting.

Set Size menu for Manual Env
7 3/4 Envelope
9 Envelope
10 Envelope
C5 Envelope
B5 Envelope
DL Envelope
Other Envelope

Lets you specify the size of the envelope being manually loaded

Note: 10 Envelope is the US factory default setting. DL Envelope is the
international factory default setting.

Set Type menu for Tray 1
Plain Paper
Card Stock
Transparency
Recycled
Labels
Bond
Letterhead
Preprinted
Colored Paper
Light Paper
Heavy Paper
Rough/Cotton
Custom Type <x>

Lets you specify the type of paper loaded in Tray 1

Notes:

• Plain Paper is the factory default setting for Tray 1.

• If available, a user‑defined name will appear instead of Custom
Type <x>.

• Use this menu item to configure automatic tray linking.

Understanding printer menus 68



Menu item Description

Set Type menu for Tray 2
Plain Paper
Card Stock
Recycled
Labels
Bond
Letterhead
Preprinted
Colored Paper
Light Paper
Heavy Paper
Rough/Cotton
Custom Type <x>

Lets you specify the type of paper loaded in Tray 2

Notes:

• Custom Type <x> is the factory default setting.

• If available, a user‑defined name will appear instead of Custom
Type <x>.

• Use this menu item to configure automatic tray linking.

Set Type menu for Manual Paper
Plain Paper
Card Stock
Transparency
Labels
Bond
Letterhead
Preprinted
Colored Paper
Light Paper
Heavy Paper
Rough/Cotton
Custom Type <x>

Lets you specify the type of paper being manually loaded

Note: Plain Paper is the factory default setting.

Set Type menu for Manual Env
Envelope
Custom Type <x>

Lets you specify the type of envelope being manually loaded

Note: Envelope is the factory default setting.

Configure MP menu

Menu item Description

Configure MP
Cassette
Manual

Determines when the printer selects paper from the multipurpose feeder

Notes:

• Cassette is the factory default setting.

• The Cassette setting configures the multipurpose feeder as an
automatic paper source.

• When Manual is selected, the multipurpose feeder can be used only
for manual feed print jobs.
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Paper Texture menu
In the Paper Texture menu, the Select Type and Select Texture features work together to enable you to select
the texture for a specific type of paper.

Menu item Description

Select Type
Plain Texture
Card Stock Texture
Transparency Texture
Recycled Texture
Labels Texture
Bond Texture
Envelope Texture
Letterhead Texture
Preprinted Texture
Colored Texture
Light Texture
Heavy Texture
Rough Texture
Custom <x> Texture

Specifies the paper type

Select Texture
Smooth
Normal
Rough

After you select a setting for Select Type, the Select Texture feature lets
you set the texture for that type of media.

Notes:

• Normal is the factory default setting for most items.

• Rough is the factory default setting for Bond.

• When Rough Texture is the setting selected for Select Type, Rough
is the only Select Texture setting available.

• Settings appear only if the paper is supported.

Paper Weight menu
In the Paper Weight menu, the Select Type and Select Weight features work together to enable you to select
the weight for a specific type of paper.
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Menu item Description

Select Type
Plain Weight
Card Stock Weight
Transparency Weight
Recycled Weight
Labels Weight
Bond Weight
Envelope Weight
Letterhead Weight
Preprinted Weight
Colored Weight
Light Weight
Heavy Weight
Rough Weight
Custom <x> Texture

Specifies the paper type

Select Weight
Light
Normal
Heavy

After you select a setting for Select Type, the Select Weight
feature lets you set the weight for that type of media.

Notes:

• Normal is the factory default setting for most items.

• When Light Weight is the setting selected for Select Type,
Light is the only Select Weight setting available.

• When Heavy Weight is the setting selected for Select Type,
Heavy is the only Select Weight setting available.

• Settings appear only if the paper is supported.

Paper Loading menu

Menu item Description

Select Type
Recycled Loading
Bond Loading
Letterhead loading
Preprinted Loading
Colored Loading
Light Loading
Heavy Loading
Custom Loading

Specifies the paper type

Note: After you select the type of paper, the Set Loading menu
appears.

Set Loading

• Duplex

• Off

Specifies whether duplex (2‑sided) printing is turned on

Note: Off is the factory default setting.
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Custom Types menu

Menu item Description

Custom Type <x>
Paper
Card Stock
Transparency
Labels
Envelope
Rough/Cotton

Name a Custom Type <x>, and this user‑defined name displays instead
of Custom Type <x>.

Notes:

• The Custom Name must be limited to 16 characters.

• Paper is the factory default setting for the Custom Type.

• The custom media type must be supported by the selected tray or
feeder in order for you to print from that source.

Recycled
Paper
Card Stock
Transparency
Labels
Envelope
Rough/Cotton

Assign a paper type for the Recycled paper type loaded, and it will also
be the Recycled paper type in other menus.

Notes:

• Paper is the factory default setting.

• The Recycled type must be supported by the selected tray or
feeder in order for you to print from that source.

Universal Setup menu
These menu items are used to specify the height, width, and feed direction of the Universal Paper Size. The
Universal Paper Size is a user‑defined paper size. It is listed with the other paper size settings and includes
similar options, such as support for duplex printing and printing multiple pages on one sheet.

Menu item Description

Units of Measure
Inches
Millimeters

Identifies the units of measure

Notes:

• Inches is the US factory default setting.

• Millimeters is the international factory default setting.

Portrait Width
3–14.17 inches
76–360 mm

Sets the portrait width

Notes:

• If the width exceeds the maximum, then the printer uses the
maximum width allowed.

• 8.5 inches is the US factory default setting. Inches can be
increased in 0.01‑inch increments.

• 216 mm is the international factory default setting. Millimeters
can be increased in 1‑mm increments.
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Menu item Description

Portrait Height
3–14.17 inches
76–360 mm

Sets the portrait height

Notes:

• If the height exceeds the maximum, then the printer uses the
maximum height allowed.

• 14 inches is the US factory default setting. Inches can be
increased in 0.01‑inch increments.

• 356 mm is the international factory default setting. Millimeters
can be increased in 1‑mm increments.

Feed Direction
Short Edge
Long Edge

Specifies the feed direction

Notes:

• Short Edge is the factory default setting.

• Long Edge appears only if the longest edge is shorter than the
maximum length supported in the tray.

Reports menu

Reports menu

To print a report, use the arrow buttons to navigate to the type of report you want, and then press .

Menu item Description

Menu Settings Page
<none>

Prints a report containing information about paper loaded into trays,
installed memory, the total page count, alarms, timeouts, the printer control
panel language, the TCP/IP address, the status of supplies, the status of the
network connection, and other information

Device Statistics
<none>

Prints a report containing printer statistics such as supply information and
details about printed pages

Network Setup Page
<none>

Prints a report containing information about the network printer settings,
such as the TCP/IP address information

Note: This menu item appears only for network printers or printers
connected to print servers.

Network <x> Setup Page
<none>

Prints a report containing information about the network printer settings,
such as the TCP/IP address information

Notes:

• This menu item is available when more than one network option is
installed.

• This menu item appears only for network printers or printers
connected to print servers.
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Menu item Description

Print Fonts
PCL Fonts
PostScript Fonts

Prints a report in English of all the fonts available for the printer language
currently set in the printer

Note: A separate list is available for PCL and PostScript emulations. Each
emulation report contains print samples and information about the
available fonts for each language.

Print Directory
<none>

Prints a list of all the resources stored on an optional flash memory card

Notes:

• Job Buffer Size must be set to 100%.

• The optional flash memory must be installed correctly and working
properly.

Asset Report
<none>

Prints a report containing asset information including the printer serial
number and model name. The report contains text and UPC barcodes that
can be scanned into an asset database.

Settings menu

General Settings menu

Menu item Description

Display Language
English
Francais
Deutsch
Italiano
Espanol
Dansk
Norsk
Nederlands
Svenska
Portuguese
Suomi
Russian
Polski
Magyar
Turkce
Cesky
Simplified Chinese
Traditional Chinese
Korean
Japanese

Sets the language of the text appearing on the display

Note: All languages may not be available for all printers.
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Menu item Description

Eco‑Mode
Off
Energy
Paper
Energy/Paper

Note: Off is the factory default setting.

Quiet Mode
Off
On

Note: Off is the factory default setting.

Run Initial Setup
Yes
No

Before running the Setup Wizard, the default setting is Yes, but
after running the wizard, the default setting is No.

Alarm
Cartridge Alarm

Off
Single

The display shows a message when the toner is low

Notes:

• Off is the factory default setting. The Toner is low
message will appear as a warning.

• Single means the Toner is low message will appear
and the indicator light will blink red.

Timeouts
Power Saver

Disabled
1–240

Sets the amount of time in minutes the printer waits after a job
is printed before it goes into a reduced power state

Note: Disabled does not appear unless Energy Conserve is
Off.

Timeouts
Print Timeout

Disabled
1–255

Sets the amount of time in seconds the printer waits to receive
an end‑of‑job message before canceling the remainder of the
print job

Notes:

• 90 seconds is the factory default setting.

• When the timer expires, any partially printed page still in
the printer is printed, and then the printer checks to see if
any new print jobs are waiting.

• Print Timeout is available only when using PCL. This
setting has no effect on PostScript emulation print jobs.

Timeouts
Wait Timeout

Disabled
15–65535

Sets the amount of time in seconds the printer waits for
additional data before canceling a print job

Notes:

• 40 seconds is the factory default setting.

• Wait Timeout is available only when the printer is using
PostScript emulation. This setting has no effect on PCL
emulation print jobs.
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Menu item Description

Print Recovery
Auto Continue

Disabled
5–255

Lets the printer automatically continue printing from certain
offline situations when not resolved within the specified time
period

Notes:

• Disabled is the factory default setting.

• 5–255 is a range of time in seconds.

Print Recovery
Jam Recovery

On
Off
Auto

Specifies whether the printer reprints jammed pages

Notes:

• Auto is the factory default setting. The printer reprints
jammed pages unless the memory required to hold the
pages is needed for other printer tasks.

• On sets the printer to always reprint jammed pages.

• Off sets the printer to never reprint jammed pages.

Print Recovery
Page Protect

On
Off

Lets the printer successfully print a page that may not have
printed otherwise

Notes:

• Off is the factory default setting. Off prints a partial page
when there is not enough memory to print the whole
page.

• On sets the printer to process the whole page so that the
entire page prints.

Factory Defaults
Do Not Restore
Restore Now

Returns the printer settings to the factory default settings

Notes:

• Do Not Restore is the factory default setting. Do Not
Restore keeps the user‑defined settings.

• Restore Now returns all printer settings to the factory
default settings except those in the Network/Ports menu.
All downloads stored in RAM are deleted. Downloads
stored in flash memory are not affected.
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Setup menu

Menu item Description

Printer Language
PS Emulation
PCL Emulation

Sets the default printer language

Notes:

• PostScript emulation uses a PS interpreter for processing
print jobs. PCL emulation uses a PCL interpreter for
processing print jobs.

• The factory default printer language is PCL Emulation.

• Setting a printer language as the default does not
prevent a software program from sending print jobs that
use another printer language.

Print Area
Normal
Whole Page

Sets the logical and physical printable area

Notes:

• Normal is the factory default setting. When attempting to
print data in the non‑printable area defined by the
Normal setting, the printer clips the image at the
boundary.

• The Whole Page setting allows the image to be moved
into the non‑printable area defined by the Normal setting,
but the printer will clip the image at the Normal setting
boundary.

• The Whole Page setting affects only pages printed using
a PCL 5e interpreter. This setting has no effect on pages
printed using the PCL XL or PostScript interpreter.

Download Target
RAM
Flash

Sets the storage location for downloads

Notes:

• RAM is the factory default setting.

• Flash appears only if a flash option is installed.

• Storing downloads in RAM is temporary.

Resource Save
On
Off

Specifies how the printer handles temporary downloads, such
as fonts and macros stored in RAM, when the printer receives
a job that requires more memory than is available

Notes:

• Off is the factory default setting. Off sets the printer to
retain the downloads only until memory is needed.
Downloads are deleted in order to process print jobs.

• The On setting retains the downloads during language
changes and printer resets. If the printer runs out of
memory, downloads are not deleted.

Print All Order
Alphabetically
Newest First
Oldest First

Sets the order in which the print jobs are printed.

Note: Alphabetically is the factory default setting.
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Finishing menu

Menu item Description

Sides (Duplex)
2‑sided
1‑sided

Specifies whether duplex (2‑sided) printing is set as the default for all print jobs

Notes:

• 1‑sided is the factory default setting.

• To set 2‑sided printing from the software program, for Windows users,
click File > Print, and then click Properties, Preferences, Options, or
Setup. For Macintosh users, choose File > Print, and then adjust the
settings from the print dialog and pop‑up menus.

Duplex Binding
Long Edge
Short Edge

Defines the way duplexed pages are bound and how the printing on the back
of the page is oriented in relation to the printing on the front of the page

Notes:

• Long Edge is the factory default setting.

• Long Edge specifies that binding be placed on the left edge of portrait
pages and the top edge of landscape pages.

• Short Edge specifies that binding be placed on the top edge of portrait
pages and the left edge of landscape pages.

Copies
1–999

Specifies a default number of copies for each print job

Note: 1 is the factory default setting.

Blank Pages
Do Not Print
Print

Specifies whether blank pages are inserted in a print job

Note: Do Not Print is the factory default setting.

Collate
Off (1,1,1,2,2,2)
On (1,2,1,2,1,2)

Stacks the pages of a print job in sequence when printing multiple copies

Notes:

• On is the factory default setting, so the pages will be printed sequentially.

• Both settings print the entire job the same number of times.

Separator Sheets
None
Between Copies
Between Jobs
Between Pages

Specifies whether blank separator sheets are inserted

Notes:

• None is the factory default setting.

• Between Copies inserts a blank sheet between each copy of a print job if
Collate is On. If Collation is Off, a blank page is inserted between each
set of printed pages, such as after all page 1s and after all page 2s.

• Between Jobs inserts a blank sheet between print jobs.

• Between Pages inserts a blank sheet between each page of the print job.
This setting is useful when printing transparencies or inserting blank
pages in a document for notes.

Separator Source
Tray <x>
Multi‑Purpose Feeder

Specifies the paper source for separator sheets

Notes:

• Tray 1 (standard tray) is the factory default setting.

• Multi‑Purpose Feeder appears as a value only if it is a supported option
on the printer and if Configure MP is set to Cassette.
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Menu item Description

N‑up (pages‑side)
Off
2‑Up
3‑Up
4‑Up
6‑Up
9‑Up
12‑Up
16‑Up

Specifies that multiple‑page images be printed on one side of a sheet of paper.

Notes:

• Off is the factory default setting.

• The number selected is the number of page images that will print per
side.

N‑up Ordering
Horizontal
Reverse Horizontal
Reverse Vertical
Vertical

Specifies the positioning of multiple‑page images when using N‑up
(pages‑sides)

Notes:

• Horizontal is the factory default setting.

• Positioning depends on the number of images and whether the images
are in portrait or landscape orientation.

Orientation
Auto
Landscape
Portrait

Specifies the orientation of a multiple‑page sheet

Notes:

• Auto is the factory default setting. The printer chooses between portrait
and landscape.

• Landscape uses long edge.

• Portrait uses short edge.

N‑up Border
None
Solid

Prints a border around each page image when using N‑up (pages‑sides)

Note: None is the factory default setting.

Quality menu

Menu item Description

Print Resolution
300 dpi
600 dpi
1200 dpi
1200 IQ
2400 IQ

Specifies the printed output resolution

Note: 600 dpi is the factory default setting.

Toner Darkness
1–10

Lightens or darkens the printed output

Notes:

• 8 is the factory default setting.

• Selecting a smaller number can help conserve toner.
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Menu item Description

Enhance Fine Lines
On
Off

Enables a print mode preferable for files such as architectural drawings, maps,
electrical circuit diagrams, and flow charts

Notes:

• Off is the factory default setting.

• To set Enhance Fine Lines, with a document open, click File > Print, and
then click Properties, Preferences, Options, or Setup for Windows users.
For Macintosh users, choose File> Print, and then adjust the settings from
the print dialog and pop‑up menus.

• To set Enhance Fine Lines using the Embedded Web Server, type the
network printer IP address in a browser window.

Gray Correction
Auto
Off

Choose whether to apply Gray Correction on printed gray images. The Auto
setting automatically applies Gray Correction and Off does not.

Note: Off is the factory default setting.

Pixel Boost
Off
Fonts
Horizontally
Vertically
Both directions

Choose whether to make characters more distinct and definite. Pixel Boost may
be needed when using certain fonts.

Note: Off is the factory default setting.

Brightness
‑6–6

Adjusts or darkens printed output and conserves toner

Note: 0 is the factory default setting.

Contrast
0–5

Adjusts the contrast of printed objects

Note: 0 is the factory default setting.

Utilities menu

Menu item Description

Format Flash
No
Yes

Formats the flash memory. Flash memory refers to the memory added by
installing an optional flash memory card in the printer.

Warning—Potential Damage: Do not turn off the printer while the flash
memory is formatting.

Notes:

• An optional flash memory card must be installed in the printer and
operating properly for this menu item to be available.

• No cancels the format request.

• Selecting Yes deletes all data stored in flash memory.
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Menu item Description

Defragment Flash
No
Yes

Prepares the flash memory to receive new data by retrieving lost storage space

Warning—Potential Damage: Do not turn off the printer while the flash
memory is defragmenting.

Notes:

• An optional flash memory card must be installed in the printer and
operating properly for this menu item to be available. The flash memory
card must not be Read/Write or Write protected.

• No cancels the defragment request.

• Selecting Yes reformats the flash memory after transferring all downloads
to regular printer memory. When formatting is complete, the downloads
are loaded back into flash memory.

Hex Trace
Activate

Assists in isolating the source of a print job problem

Notes:

• When Activate is selected, all data sent to the printer is printed in
hexadecimal and character representation and control codes are not
executed.

• To exit Hex Trace, turn the printer off or reset the printer.

Coverage Estimator
Off
On

Provides an estimate of the percentage coverage of black on a page. The
estimate is printed on a separator page.

Note: Off is the factory default setting.

PostScript menu

Menu item Description

Print PS Error
On
Off

Prints a page containing the PostScript error

Note: Off is the factory default setting.

Font Priority
Resident
Flash/Disk

Establishes the font search order

Notes:

• Resident is the factory default setting.

• A formatted flash memory option card must be installed in the printer
and operating properly for this menu item to be available.

• The flash memory option cannot be Read/Write, Write, or
password‑protected.

• Job Buffer Size must not be set to 100%.
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PCL Emul menu

Menu item Description

Font Source
Resident
Download
Flash
All

Specifies the set of fonts available

Notes:

• Resident is the factory default setting. It shows the factory default set
of fonts downloaded into RAM.

• Download appears only if downloaded fonts exist. It shows all the
fonts downloaded into RAM.

• Flash appears only if a flash option containing fonts is installed.

• A flash option must be properly formatted and cannot be Read/Write,
Write, or password protected.

• All shows all fonts available to any option.

Font Name
<x>

Lets you view or change the setting from a selection list

Symbol Set
<x>

Lets you view or change the setting from a selection list

PCL Emulation Settings
Point Size

1.00–1008.00

Changes the point size for scalable typographic fonts

Notes:

• 12 is the factory default setting.

• Point Size refers to the height of the characters in the font. One point
equals approximately 1/72 of an inch.

• Point sizes can be increased or decreased in 0.25‑point increments.

PCL Emulation Settings
Pitch

0.08–100

Specifies the font pitch for scalable monospaced fonts

Notes:

• 10 is the factory default setting.

• Pitch refers to the number of fixed‑space characters per inch (cpi).

• Pitch can be increased or decreased in 0.01‑cpi increments.

• For nonscalable monospaced fonts, the pitch appears on the display
but cannot be changed.

PCL Emulation Settings
Orientation

Portrait
Landscape

Specifies the orientation of text and graphics on the page

Notes:

• Portrait is the factory default setting.

• Portrait prints text and graphics parallel to the short edge of the
page.

• Landscape prints text and graphics parallel to the long edge of the
page.
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Menu item Description

PCL Emulation Settings
Lines per Page

1–255
60
64

Specifies the number of lines that print on each page

Notes:

• 60 is the US factory default setting. 64 is the international default
setting.

• The printer sets the amount of space between each line based on
the Lines per Page, Paper Size, and Orientation settings. Select the
desired Paper Size and Orientation before setting Lines per Page.

PCL Emulation Settings
A4 Width

198 mm
203 mm

Sets the printer to print on A4‑size paper

Notes:

• 198 mm is the factory default setting.

• The 203‑mm setting sets the width of the page to allow the printing
of eighty 10‑pitch characters.

PCL Emulation Settings
Auto CR after LF

On
Off

Specifies whether the printer automatically performs a carriage return (CR)
after a line feed (LF) control command

Note: Off is the factory default setting.

PCL Emulation Settings
Auto LF after CR

On
Off

Specifies whether the printer automatically performs a line feed (LF) after
a carriage return (CR) control command

Note: Off is the factory default setting.

Tray Renumber
Assign MP Feeder

Off
None
0–199

Assign Tray <x>
Off
None
0–199

Assign Manual Paper
Off
None
0–199

Assign Man Env
Off
None
0–199

Configures the printer to work with printer software or programs that use
different source assignments for trays, drawers, and feeders

Notes:

• Off is the factory default setting.

• None is not an available selection. It is displayed only when it is
selected by the PCL 5 interpreter.

• None ignores the Select Paper Feed command.

• 0–199 allows a custom setting to be assigned.

Tray Renumber
View Factory Def

None

Displays the factory default setting assigned to each tray, drawer, or feeder
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Menu item Description

Tray Renumber
Restore Defaults

Yes
No

Returns all tray, drawer, and feeder assignments to the factory default
settings

Network/Ports menu

Network Card menu

Menu item Description

View Card Status
Connected
Disconnected

Allows you to ascertain whether the Network Card is connected.

View Card Speed Reflects the speed of a currently active network card.

View Network Address
UAA
LAA

Both addresses are represented by 12‑digit hexadecimal numbers.

Job Timeout

0‑225 seconds

Sets the amount of time in seconds that a network print job can take before
it is canceled.

Notes:

• 90 seconds is the factory default setting.

• A setting value of 0 disables the timeout.

• If a value of 1–9 is selected, the setting is saved as 10.

Banner Page
On
Off

Allows the printer to print a banner page.

Note: Off is the factory default setting.

TCP/IP menu
Use the following menu items to view or set the TCP/IP information.

Note: This menu is available only for network models or printers attached to print servers.

Menu item Description

TCP/IP
Activate

On
Off

Specifies whether to activate TCP/IP

Note: On is the factory default setting.

TCP/IP
View Hostname

Shows the current TCP/IP hostname
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Menu item Description

TCP/IP
IP Address

Lets you view or change the current TCP/IP Address information

Note: This is a four‑field IP Address.

TCP/IP
Netmask

Lets you view or change the current TCP/IP Netmask information

Note: This is a four‑field IP Netmask.

TCP/IP
Gateway

Lets you view or change the current TCP/IP Gateway information

Note: This is a four‑field IP Gateway.

TCP/IP
Enable DHCP

Yes
No

Lets you view or change the setting

Note: Yes is the factory default setting.

TCP/IP
AutoIP

Yes
No

Lets you view or change the setting

Note: Yes is the factory default setting.

TCP/IP
Enable FTP/TFTP

Yes
No

Lets you view or change the setting

Note: Yes is the factory default setting.

TCP/IP
Enable HTTP Server

Yes
No

Lets you view or change the setting

Note: Yes is the factory default setting.

TCP/IP
WINS Server Address
DNS Server Address

Lets you view or change the setting

Note: This is a four‑field IP address.

IPv6 menu
Use the following menu items to view or set the Internet Protocol version 6 (IPv6) information.

Note: This menu is available only for network models or printers attached to print servers.

Menu item Description

IPv6
Enable IPv6

On
Off

Enables IPv6 in the printer

Note: On is the factory default setting.

IPv6
Auto Configuration

On
Off

Enables the network adapter to accept the automatic IPv6 address
configuration entries provided by a router

Note: On is the factory default setting.
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Menu item Description

IPv6
View Hostname
View Address
View Router Address

Shows the setting

Note: These settings can be changed only from the Embedded
Web Server.

IPv6
Enable DHCPv6

Yes
No

Enables DHCPv6 in the printer

Note: Yes is the factory default setting.

Network menu

Menu item Description

PCL SmartSwitch
On
Off

Sets the printer to automatically switch to PCL emulation when a print job
requires it, regardless of the default printer language

Notes:

• On is the factory default setting.

• When the Off setting is used, the printer does not examine incoming
data.

• When the Off setting is used, the printer uses PostScript emulation if PS
SmartSwitch is set to On. It uses the default printer language specified in
the Setup menu if PS SmartSwitch is set to Off.

PS SmartSwitch
On
Off

Sets the printer to automatically switch to PS emulation when a print job
requires it, regardless of the default printer language

Notes:

• On is the factory default setting.

• When the Off setting is used, the printer does not examine incoming
data.

• When the Off setting is used, the printer uses PCL emulation if PCL
SmartSwitch is set to On. It uses the default printer language specified in
the Setup menu if PCL SmartSwitch is set to Off.

NPA Mode
Off
Auto

Sets the printer to perform the special processing required for bidirectional
communication following the conventions defined by the NPA protocol

Notes:

• Auto is the factory default setting.

• Changing this setting from the printer control panel and then exiting the
menus causes the printer to restart. The menu selection is updated.
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Menu item Description

Network Buffer
Disabled
Auto
3K to <maximum size allowed>

Sets the size of the network input buffer

Notes:

• Auto is the factory default setting.

• The value can be changed in 1K increments.

• The maximum size allowed depends on the amount of memory in the
printer, the size of the other link buffers, and whether Resource Save is
set to On or Off.

• To increase the maximum size range for the Network Buffer, disable or
reduce the size of the parallel and USB buffers.

• Changing this setting from the printer control panel and then exiting the
menus causes the printer to restart. The menu selection is updated.

Mac Binary PS
On
Off
Auto

Sets the printer to process Macintosh binary PostScript print jobs

Notes:

• Auto is the factory default setting.

• The Off setting filters print jobs using the standard protocol.

• The On setting processes raw binary PostScript print jobs.

Network Setup Reflects the network setup for your printer

AppleTalk menu

Menu item Description

Activate
Off
On

Activates or deactivates AppleTalk support

Note: On is the factory default setting.

View Name
<none>

Shows the assigned AppleTalk name

View Address
<none>

Shows the assigned AppleTalk address

Set Zone
<list of zones available on the
network>

Provides a list of AppleTalk zones available on the network

Note: The factory default setting is the default zone for the network. If no
default zone exists, the zone marked with an * is the factory default
setting.
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USB menu

Menu item Description

PCL SmartSwitch
On
Off

Sets the printer to automatically switch to PCL emulation when a print job
received through a USB port requires it, regardless of the default printer
language

Notes:

• On is the factory default setting.

• When the Off setting is used, the printer does not examine incoming data.

• When the Off setting is used, the printer uses PostScript emulation if the
PS Smartswitch setting is On. It uses the default printer language
specified in the Setup menu if the PS SmartSwitch setting is Off.

PS SmartSwitch
On
Off

Sets the printer to automatically switch to PS emulation when a print job received
through a USB port requires it, regardless of the default printer language

Notes:

• On is the factory default setting.

• When the Off setting is used, the printer does not examine incoming data.

• When the Off setting is used, the printer uses PCL emulation if the PCL
Smartswitch setting is On. It uses the default printer language specified in
the Setup menu if the PCL SmartSwitch setting is Off.

NPA Mode
On
Off
Auto

Sets the printer to perform the special processing required for bidirectional
communication following the conventions defined by the NPA protocol

Notes:

• Auto is the factory default setting.

• Changing this setting causes the printer to restart.

USB Buffer
Disabled
Auto
3K to <maximum size allowed>

Sets the size of the USB input buffer

Notes:

• Auto is the factory default setting.

• The Disabled setting turns off job buffering. Any jobs already buffered are
printed before normal processing is resumed.

• The USB buffer size value can be changed in 1K increments.

• The maximum size allowed depends on the amount of memory in the
printer, the size of the other link buffers, and whether the Resource Save
setting is On or Off.

• To increase the maximum size range for the USB Buffer, disable or reduce
the size of the parallel and network buffers.

• Changing this setting causes the printer to restart.

Mac Binary PS
On
Off
Auto

Sets the printer to process Macintosh binary PostScript print jobs

Notes:

• Auto is the factory default setting.

• The Off setting filters print jobs using the standard protocol.

• The On setting processes raw binary PostScript print jobs.

Understanding printer menus 88



Menu item Description

USB with ENA
ENA Address
ENA Netmask
ENA Gateway

Sets the network address, netmask, and gateway information for an external
print server that is attached to the printer using a USB cable

Note: This menu item and its submenus are available only if the printer is
attached to an external print server through the USB port.

Parallel menu

Menu item Description

PCL SmartSwitch
On
Off

Sets the printer to automatically switch to PCL emulation when a print job
received through a USB port requires it, regardless of the default printer
language

Notes:

• On is the factory default setting.

• When the Off setting is used, the printer does not examine incoming data.

• When the Off setting is used, the printer uses PostScript emulation if PS
SmartSwitch is set to On. It uses the default printer language specified in
the Setup menu if PS SmartSwitch is set to Off.

PS SmartSwitch
On
Off

Sets the printer to automatically switch to PS emulation when a print job received
through a USB port requires it, regardless of the default printer language

Notes:

• On is the factory default setting.

• When the Off setting is used, the printer does not examine incoming data.

• When the Off setting is used, the printer uses PCL emulation if PCL
SmartSwitch is set to On. It uses the default printer language specified in
the Setup menu if PCL SmartSwitch is set to Off.

NPA Mode
Off
Auto

Sets the printer to perform the special processing required for bidirectional
communication following the conventions defined by the NPA protocol

Notes:

• Auto is the factory default setting.

• Changing this setting automatically resets the printer.
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Menu item Description

Parallel Buffer
Disabled
Auto
3K to <max size allowed>

Sets the size of the parallel input buffer

Notes:

• Auto is the factory default setting.

• The Disabled setting turns off job buffering. Any jobs already buffered on
the disk are printed before normal processing is resumed.

• The parallel buffer size setting can be changed in 1‑K increments.

• The maximum size allowed depends on the amount of memory in the
printer, the size of the other link buffers, and whether Resource Save is
set to On or Off.

• To increase the maximum size range for the Parallel Buffer, disable or
reduce the size of the USB and network buffers.

• Changing this setting automatically resets the printer.

Advanced Status
Off
On

Enables bidirectional communication through the parallel port

Notes:

• On is the factory default setting.

• The Off setting disables parallel port negotiation.

Protocol
Standard
Fastbytes

Specifies the parallel port protocol

Notes:

• Fastbytes is the factory default setting. It provides compatibility with most
existing parallel ports and is the recommended setting.

• The Standard setting tries to resolve parallel port communication
problems.

Honor Init
On
Off

Determines whether the printer honors printer hardware initialization requests
from the computer

Notes:

• Off is the factory default setting.

• The computer requests initialization by activating the Init signal from the
parallel port. Many personal computers activate the Init signal each time
the computer is turned on.

Parallel Mode 2
On
Off

Determines whether the parallel port data is sampled on the leading or trailing
edge of strobe

Note: On is the factory default setting.

Mac Binary PS
On
Off
Auto

Sets the printer to process Macintosh binary PostScript print jobs

Notes:

• Auto is the factory default setting.

• The Off setting filters print jobs using the standard protocol.

• The On setting processes raw binary PostScript print jobs.
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Menu item Description

Parallel with ENA
ENA Address
ENA Netmask
ENA Gateway

Sets the network address, netmask, and gateway information for an external
print server that is attached to the printer using a parallel cable.

Note: This menu is available only if the printer is attached to an external print
server through the parallel port.
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Understanding printer messages
When Manual Feeder appears on the display, it refers to the multipurpose feeder.

List of status and error messages

Busy
Wait for the message to clear.

Canceling
Wait for the message to clear.

Close front door
Close the front door of the printer.

Defragmenting Flash DO NOT POWER OFF
Wait for the message to clear.

Warning—Potential Damage: Do not turn the printer off while this message appears on the display.

DO NOT TOUCH Reading flash data DO NOT POWER OFF
As a part of this message, a bar graphic appears on one line of the display, indicating the percentage of
processing time completed.

Wait for the message to clear. The message displays until all code is received and the processing is complete.

Warning—Potential Damage: If your printer is connected to a computer by a USB cable, do not touch
the printer control panel while this message appears on the display. Do not turn the printer off while this
message appears.

Flushing buffer
Wait for the message to clear.

Formatting Flash DO NOT POWER OFF
Wait for the message to clear.

Warning—Potential Damage: Do not power off while the printer is formatting the flash memory.
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Hex Trace
The printer is in Hex Trace mode.

Invalid Engine Code
You need to download valid engine code for the printer.

Note: Engine code may be downloaded while this message appears on the display.

Invalid Network Code
You need to download valid network printing code for the internal print server. The internal print server is
a hardware option installed inside the printer.

Note: Network code may be downloaded while this message appears on the display.

Load manual feeder with <x>
Try one or more of the following:

• Load the specified paper in the multipurpose feeder.

• Cancel the current job.

Load <src> with <x>
Try one or more of the following:

• Load the tray or other source with the correct paper type and size.

• Cancel the current job.

Network/Network <x>
The printer is connected to the network.

Network indicates that the printer is using the standard network port built into the printer system board.
Network <x> indicates that an internal print server is installed inside the printer or that the printer is
connected to an external print server.

Power Saver
The printer is saving power while it waits for the next print job. Send a job to print to take the printer out of
Power Saver mode.

Programming Engine Code DO NOT POWER OFF
Wait for the message to clear.

Warning—Potential Damage: Do not turn the printer power off while Programming Engine Code
appears on the display.
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Programming flash DO NOT POWER OFF
Wait for the message to clear.

Warning—Potential Damage: Do not turn the printer power off while Programming flash appears
on the display.

Programming System Code DO NOT POWER OFF
Wait for the message to clear.

Warning—Potential Damage: Do not turn the printer power off while Programming System Code
appears on the display.

Ready
The printer is ready to receive print jobs.

Remove paper from standard output bin
Remove the stack of paper from the standard exit bin.

Toner is low
Try one or more of the following:

• Replace the toner cartridge.

• Press  to clear the message and continue printing.

USB/USB <x>
The printer is using a USB cable connection. The USB port is the active communication link.

Waiting
The printer has received data to print, but is waiting for an End‑of‑Job command, a Form Feed command,
or additional data.

• Press  to print the contents of the buffer.

• Cancel the current print job.

31.yy Replace defective or missing cartridge
The toner cartridge is either missing or not functioning properly.

Try one or more of the following:

• Remove the toner cartridge, and then reinstall it.

• Remove the toner cartridge, and then install a new one.
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32.yy Cartridge part number unsupported by device
Remove the toner cartridge, and then install a supported one.

34 Short paper
Try one or more of the following:

• Load the appropriate paper in the tray.

• Press the arrow buttons until Continue appears, and then press  to clear the message and print
the job using a different paper tray.

• Check tray length and width guides and make sure the paper is properly loaded in the tray.

• Check the Print Properties settings to make sure the print job is requesting the correct paper size and
type.

• Check that the paper size is correctly set. For example, if the MP Feeder Size is set to Universal, make
sure the paper is large enough for the data being printed.

• Cancel the current print job.

35 Insufficient memory to support Resource Save feature

The printer lacks sufficient memory to save settings. Install additional memory, or press  to disable
Resource Save and continue printing.

37 Insufficient memory for Flash Memory Defragment operation
Try one or more of the following:

• Press the arrow buttons until Continue appears, and then press  to stop the defragment operation
and continue printing.

• Delete fonts, macros, and other data in printer memory.

• Install additional printer memory.

37 Insufficient memory to collate job
Try one or more of the following:

• Press the arrow buttons until Continue appears, and then press  to print the portion of the job
already stored and begin collating the rest of the print job.

• Cancel the current print job.

38 Memory full
Try one or more of the following:

• Press the arrow buttons until Continue appears, and then press  to clear the message.

• Cancel the current print job.
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• Install additional printer memory.

39 Complex page, some data may not have printed
Try one or more of the following:

• Press the arrow buttons until Continue appears, and then press  to clear the message and
continue printing.

• Cancel the current print job.

• Install additional printer memory.

52 Not enough free space in flash memory for resources
Try one or more of the following:

• Press the arrow buttons until Continue appears, and then press  to stop the defragment operation
and continue printing.

Downloaded fonts and macros not previously stored in flash memory are deleted.

• Delete fonts, macros, and other data stored in flash memory.

• Upgrade to a larger capacity flash memory card.

53 Unformatted flash detected
Try one or more of the following:

• Press the arrow buttons until Continue appears, and then press  to continue printing.

• Format the flash memory. If the error message remains, the flash memory may be defective and require
replacing.

54 Standard network software error
Try one or more of the following:

• Press the arrow buttons until Continue appears, and then press  to continue printing.

• Turn the printer off and then back on to reset the printer.

• Upgrade (flash) the network firmware in the printer or print server.

56 Standard USB port disabled
Try one or more of the following:

• The printer discards any data received through the USB port. Press  to clear the message and
continue printing.

• Make sure the USB Buffer menu item is not set to Disabled.
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56 Standard parallel port disabled
Try one or more of the following:

• The printer discards any data received through the parallel port. Press  to clear the message and
continue printing.

• Make sure the Parallel Buffer menu item is not set to Disabled.

58 Too many flash options installed
Try one or more of the following:

• Turn the printer off, and then remove extra flash options:

1 Turn the printer off.

2 Unplug the power cord from the wall outlet.

3 Remove the excess flash memory.

4 Connect the power cord to a properly grounded outlet.

5 Turn the printer back on.

• Press  to clear the message and continue printing.

84 PC Kit life warning
The photoconductor kit is near exhaustion.

Try one or more of the following:

• Replace the photoconductor kit.

• Press  to clear the message and continue printing.

84 Replace PC Kit
The photoconductor kit is exhausted. Install a new photoconductor kit.

42.xy Cartridge region mismatch
Replace the toner cartridge with one that is correct for the region where you purchased your printer.

51 Defective flash detected
Try one or more of the following:

• Replace the defective flash memory card.

• Press the arrow buttons until Continue appears, and then press  to clear the message and
continue printing.
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88.yy Cartridge is low

Replace the toner cartridge, and then press  to clear the message and continue printing.

200.yy Paper jam
The message indicates either where the paper is jammed or the number of pages jammed.

1 To access the jam, try one or more of the following:

• Remove Tray 1.

• Open the front door, and then remove the photoconductor kit and toner cartridge unit.

2 Remove the jam.

3 Replace the photoconductor kit and toner cartridge unit if you removed it.

4 Close any open doors or trays.

5 Press  to continue printing.

201.yy Paper jam
The message indicates either where the paper is jammed or the number of pages jammed.

1 Open the front door, and then remove the photoconductor kit and toner cartridge unit.

2 Remove the jam.

3 Replace the photoconductor kit and toner cartridge unit.

4 Close the front door.

5 Press  to continue printing.

202.yy Paper jam
The message indicates either where the paper is jammed or the number of pages jammed.

1 Open the front door.

2 Open the rear door.

3 Remove the jam.

4 Close both doors.

5 Press  to continue printing.
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231.yy Paper jam
The message indicates either where the paper is jammed or the number of pages jammed.

1 Open the front door.

2 Open the rear door.

3 Remove the jam.

4 Close both doors.

5 Press  to continue printing.

233.yy Paper jam
The message indicates either where the paper is jammed or the number of pages jammed.

1 To access the jam, try one or more of the following:

• Remove Tray 1, and then depress the lever.

• Open the front door, and then open the rear door.

2 Remove the jam.

3 Close any open doors or trays.

4 Press  to continue printing.

234.yy Paper jam
The message indicates either where the paper is jammed or the number of pages jammed.

1 To access the jam, try one or more of the following:

• Open the front door, and then open the rear door.

• Remove Tray 1, and then depress the lever.

2 Remove the jam.

3 Close any open doors or trays.

4 Press  to continue printing.

235.yy Paper jam
The message indicates either where the paper is jammed or the number of pages jammed.

1 Remove the jam from the standard exit bin.

2 Check the paper size to ensure that it is supported by the printer.

3 Press  to continue printing.
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24x.yy Paper jam
The message indicates either where the paper is jammed or the number of pages jammed.

1 To access the jam, try one or more of the following:

• Remove Tray 1.

• Open the front door, and then remove the photoconductor kit and toner cartridge unit.

• Remove Tray 2.

2 Remove the jam.

3 Replace the photoconductor kit and toner cartridge unit if you removed it.

4 Close any open doors or trays.

5 Press  to continue printing.

251.yy Paper jam
The message indicates either where the paper is jammed or the number of pages jammed.

1 Remove the jam from the multipurpose feeder.

2 Press  to continue printing.
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Maintaining the printer
Periodically, certain tasks are required to maintain optimum print quality.

Cleaning the exterior of the printer
1 Make sure that the printer is turned off and unplugged from the wall outlet.

CAUTION—SHOCK HAZARD: To avoid the risk of electric shock when cleaning the exterior of the
printer, unplug the power cord from the wall outlet and disconnect all cables to the printer before
proceeding.

2 Remove all paper from the printer.

3 Dampen a clean, lint‑free cloth with water.

Warning—Potential Damage: Do not use household cleaners or detergents, as they may damage the
finish of the printer.

4 Wipe only the outside of the printer.

Warning—Potential Damage: Using a damp cloth to clean the interior may cause damage to your printer.

5 Make sure all areas of the printer are dry before beginning a new print job.

Storing supplies
Choose a cool, clean storage area for the printer supplies. Store supplies right side up in their original packing
until you are ready to use them.

Do not expose supplies to:

• Direct sunlight

• Temperatures above 35°C (95°F)

• High humidity above 80%

• Salty air

• Corrosive gases

• Heavy dust

Conserving supplies

Conserving supplies using the printer control panel
There are some settings you can change from the printer control panel that will help you conserve toner and
paper. For more information, see the following table:
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Supply Path to menu item Purpose of menu item

Toner Settings > Quality Menu >
Toner Darkness

Lets you adjust the level of toner
released on a sheet of paper or
specialty media. The values range
from 1 (lightest setting) to 10 (darkest
setting), with 8 being the factory
default setting.

Paper or specialty media Settings > Finishing Menu >
N‑up

Lets you select to print two or more
page images on one side of a sheet.
Values for N‑up are 2-Up, 3-Up, 4-Up,
6-Up, 9-Up, 12-Up, and 16‑Up.

Settings > Finishing Menu >
Sides (Duplex)

Lets you print on both sides of a sheet
of paper

Conserving supplies when printing multiple copies
If you need to print several copies, you can conserve supplies by printing the first copy and checking it for
accuracy before printing the remaining copies.

Checking the status of supplies from a network computer
Note: The computer must be connected to the same network as the printer.

1 Type the printer IP address into the address field of your Web browser.

Note: If you do not know the IP address of the printer, print a network setup page and locate the IP
address in the TCP/IP section.

2 Click Device Status. The Device Status page appears, displaying a summary of supply levels.
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Ordering supplies
To order supplies in the U.S., contact Lexmark at 1-800-539-6275 for information about Lexmark authorized
supplies dealers in your area. In other countries or regions, visit the Lexmark Web Site at www.lexmark.com
or contact the place where you purchased the printer.

Note: All life estimates for printer supplies assume printing on letter‑ or A4‑size plain paper.

Ordering toner cartridges
When 88 Cartridge Low appears or when the print becomes faded, you may be able to extend the life of
the toner cartridge:

1 Remove the toner cartridge.

2 Firmly shake the cartridge side‑to‑side and front‑to‑back several times to redistribute toner.

3 Reinsert the cartridge and continue printing.

Note: Repeat this procedure multiple times until the print remains faded, and then replace the cartridge.

Part name Regular cartridge Lexmark Return Program Cartridge

For the US and Canada

Toner cartridge E260A21A E260A11A

High Yield Toner Cartridge E360H21A E360H11A

For Europe, the Middle East, and Africa

Toner cartridge E260A21E E260A11E

High Yield Toner Cartridge E360H21E E360H11E

For the Asia Pacific Region, including Australia, New Zealand, and India

Toner cartridge E260A21P E260A11P

High Yield Toner Cartridge E360H21P E360H11P

For Latin America

Toner cartridge E260A21L E260A11L

High Yield Toner Cartridge E360H21L E360H11L
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Ordering a photoconductor kit
Depending on your printer model, the printer issues a message or a light sequence to let you know the
photoconductor kit is near its end of life. At this time, order a photoconductor kit. You can also see the status
of the photoconductor kit by printing a network setup page.

Part name Part number

Photoconductor kit E260X22G

Replacing supplies

Replacing the toner cartridge
When 88 Cartridge is low appears, or when you experience faded print, remove the toner cartridge.
Firmly shake it side‑to‑side and front‑to‑back several times to redistribute the toner, and then reinsert it and
continue printing. When shaking the cartridge no longer improves the print quality, replace the toner cartridge.

Note: You can check to see approximately how much toner is left in your cartridge by printing a menu
settings page.

To replace the toner cartridge:

1 Open the front door by pressing the button on the left side of the printer and lowering the door.

2 Press the button on the base of the photoconductor kit, and then pull the toner cartridge out using the
handle.
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3 Unpack the new toner cartridge.

Warning—Potential Damage: When replacing a toner cartridge, do not leave the new cartridge exposed
to direct light for an extended period of time. Extended light exposure can cause print quality problems.

4 Rotate the cartridge in all directions to distribute the toner.

5 Install the new toner cartridge by aligning the rollers on the toner cartridge with the arrows on the tracks of
the photoconductor kit. Push the toner cartridge in as far as it will go. The cartridge clicks into place when
correctly installed.

6 Close the front door.

Replacing the photoconductor kit
The printer automatically notifies you before the photoconductor kit reaches a page maximum by showing 84
PC Kit life warning or 84 Replace PC Kit on the display. You can also see the status of the
photoconductor kit by printing a menu settings page.

When 84 PC Kit life warning or 84 Replace PC Kit first appears, you should immediately order a
new photoconductor kit. While the printer may continue to function properly after the photoconductor kit has
reached its official end‑of‑life, print quality significantly decreases.

Note: The photoconductor kit is one item only.
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1 Open the front door by pressing the button on the left side of the printer and lowering the front door.

2 Pull the photoconductor kit and toner cartridge out of the printer as a unit by pulling on the toner cartridge
handle.

Note: The photoconductor kit and toner cartridge form a unit.

Place the unit on a flat, clean surface.

3 Press the button on the base of the photoconductor kit. Pull the toner cartridge up and out using the handle.
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4 Unpack the new photoconductor kit. Be careful not to touch the photoconductor drum.

5 Insert the toner cartridge into the photoconductor kit by aligning the rollers on the toner cartridge with the
tracks. Push the toner cartridge until it clicks into place.

6 Install the unit into the printer by aligning the arrows on the guides of the unit with the arrows in the printer.
Push the unit as far as it will go.

7 After you replace the photoconductor kit, reset the photoconductor counter. To reset the counter, see the
instruction sheet that came with the new photoconductor kit.

Warning—Potential Damage: Resetting the photoconductor counter without replacing the
photoconductor may damage your printer and void your warranty.

8 Close the front door.
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Recycling Lexmark products
To return Lexmark products to Lexmark for recycling:

1 Visit our Web site at www.lexmark.com/recycle.

2 Find the product type you want to recycle, and then select your country from the list.

3 Follow the instructions on the computer screen.

Moving the printer

Before moving the printer
CAUTION—POTENTIAL INJURY: Follow these guidelines to avoid personal injury or printer damage:

• Turn the printer off using the power switch, and then unplug the power cord from the wall outlet.

• Disconnect all cords and cables from the printer before moving it.

• Lift the printer off of the optional drawer and set it aside instead of trying to lift the drawer and printer at the
same time.

Note: Use the handholds located on both sides of the printer to lift it off the optional drawer.

• Make sure your fingers are not under the printer when you set it down.

Warning—Potential Damage: Damage to the printer caused by improper moving is not covered by the
printer warranty.

Moving the printer to another location
CAUTION—POTENTIAL INJURY:  Before moving the printer, follow these guidelines to avoid personal
injury or printer damage:

• Turn the printer off using the power switch, and then unplug the power cord from the wall outlet.

• Disconnect all cords and cables from the printer before moving it.

• Lift the printer off of the optional drawer and set it aside instead of trying to lift the drawer and printer at the
same time.

Note: Use the handholds located on both sides of the printer to lift it off the optional drawer.

The printer and options can be safely moved to another location by following these precautions:

• Any cart used to move the printer must have a surface able to support the full footprint of the printer. Any
cart used to move the options must have a surface able to support the dimensions of the options.

• Keep the printer in an upright position.

• Avoid severe jarring movements.

Setting the printer up in a new location
When the printer is set up, allow clearance around it as shown.
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1 300 mm (12.0 in.)

2 300 mm (12.0 in.)

3 200 mm (8.0 in.)

4 12.7 mm (0.5 in.)

5 300 mm (12.0 in.)

Shipping the printer
When shipping the printer, use the original packaging or call the place of purchase for a relocation kit.
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Administrative support

Finding advanced networking and administrator
information
This chapter covers basic administrative support tasks. For more advanced system support tasks, see the
Networking Guide on the Software and Documentation CD and the Embedded Web Server Administrator's
Guide on the Lexmark Web site at www.lexmark.com.

Adjusting Power Saver
1 Make sure the printer is on and Ready appears.

2 From the printer control panel, press .

3 Press the arrow buttons until Settings appears, and then press .

4 Press the arrow buttons until General Settings appears, and then press .

5 Press the arrow buttons until Timeouts appears, and then press .

6 Press the arrow buttons until Power Saver appears, and then press .

7 Press the arrow buttons to increase or decrease the number of minutes before the printer enters Power

Saver mode, and then press . Available settings are Disabled and a range from 1–240 minutes.

Note: Power Saver settings can also be adjusted by issuing a Printer Job Language (PJL) command. For
more information, see the Technical Reference available on the Lexmark Web site at
www.lexmark.com/publications.

Restoring the factory default settings
1 From the printer control panel, press .

2 Press the arrow buttons until Settings appears, and then press .

3 Press the arrow buttons until General Settings appears, and then press .

4 Press the arrow buttons until Factory Defaults appears, and then press .

5 Press the arrow buttons until Restore Now appears, and then press .

Wait for Submitting Changes to appear momentarily, followed by Restoring Factory Defaults,
before the printer returns to Ready.

Warning—Potential Damage: Restore Now returns all printer settings to the factory default settings
except Network/Port menu settings. All downloads stored in RAM are deleted. Downloads stored in flash
memory are not affected.
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Using the Embedded Web Server
If the printer is installed on a network, the Embedded Web Server is available for a range of functions including:

• Viewing a virtual display of the printer control panel

• Checking the status of the printer supplies

• Configuring printer settings

• Configuring network settings

• Viewing reports

To access the Embedded Web Server, type the printer IP address into the address field of your Web browser.

Notes:

• If you do not know the IP address of the printer, then print a network setup page and locate the IP
address in the TCP/IP section.

• For more information, see the Networking Guide on the Software and Documentation CD and the
Embedded Web Server Administrator's Guide on the LexmarkTM Web site at www.lexmark.com.

Viewing reports
You can view some reports from the Embedded Web Server. These reports are useful for assessing the status
of the printer, the network, and supplies. To view reports from a network printer:

1 Type the printer IP address into the address field of your Web browser.

Note: If you do not know the IP address of the printer, then print a network setup page and locate the IP
address in the TCP/IP section.

2 Click Reports.

The following reports may be viewed from the Embedded Web Server:

Reports

Device Statistics

Device Settings

Device Information

Profiles List

Printer Server Setup Page

The reports have the following subcategories:
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Device Statistics Device Settings Device Information Printer Server Setup Page

Job Information

Jobs by Document Length

Other Job Data

Media Sheet Count

Paper Menu

Reports

Settings

Network/Ports

Reports

Network Card

TCP/IP

IPv6

USB Menu

Warnings

Device Information

Cartridge Information

Page Count

Installed Memory

Processor Speed

Serial Number

Engine ID

Loader

Kernel

Base

Network

Network Driver

Engine

Font

Ethernet10/100

Standard Network Card

Integrated Network Option
Settings

TCP/IP

IPv6

Checking the device status
From the Device Status page of the Embedded Web Server, it is possible to see tray settings, the level of toner
in the toner cartridge, the percentage of life remaining in the photoconductor kit, and capacity measurements
of certain printer parts. To access the device status:

1 Type the printer IP address in the address field of your Web browser.

Note: If you do not know the IP address of the printer, print a network setup page and locate the IP
address in the TCP/IP section.

2 Click the Device Status tab. The following menu appears:

Device Status

Toner Status

Paper Input Tray

Paper Output Bin

Device Type

Speed

Toner Cartridge Capacity

PC Unit Life Remaining

Restricting access to printer menus
You can safeguard entry to menus by creating passwords and choosing specific menus to protect. Each time
a protected menu is selected, the user will be prompted to enter the correct password.
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To protect printer menus using the Embedded Web Server:

1 Type the printer IP address into the address field of your Web browser.

Note: If you do not know the IP address of the printer, then print a network setup page and locate the IP
address in the TCP/IP section.

2 Click Settings.

3 Under Other Settings, click Security.

4 Click Web Page Password Protect. It is possible to protect entry to the Paper, Reports, Settings, and
Network/Ports menus.

5 From this screen, you may set a User Password and an Advanced Password. Determine which password
will access each menu. You may also choose not to protect a menu.

Note: The Security menu is always password‑protected when either an Advanced Password or a User
Password has been set. If both passwords have been set, then only the Advanced Password is valid for
access to the Security menu mode.

6 Click Submit to save your settings.

Setting up e‑mail alerts
You can have the printer send you an e‑mail when the supplies are getting low or when the paper needs to be
changed, added, or unjammed.

To set up e‑mail alerts:

1 Type the printer IP address into the address field of your Web browser.

Note: If you do not know the IP address of the printer, then print a network setup page and locate the IP
address in the TCP/IP section.

2 Click Settings.

3 Under Other Settings, click E‑mail Alert Setup.

4 Select the items for notification and type in the e‑mail addresses that you want to receive e‑mail alerts.

5 Click Submit.

Note: See your system support person to set up the e‑mail server.

Configuring supply notifications
You can determine how you would like to be notified when supplies run low or reach their end‑of‑life.

To configure supply notifications using the Embedded Web Server:

1 Type the printer IP address into the address field of your Web browser.

Note: If you do not know the IP address of the printer, then print a network setup page and locate the IP
address in the TCP/IP section.

2 Click Settings.

3 Click Print Settings.
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4 Click Supply Notifications.

5 From the drop‑down box for each supply, select among the options for notification. Explanations for each
option are provided.

6 Click Submit to save your selections.

Copying printer settings to other printers
Using the Embedded Web Server, you can copy printer settings to up to 15 other network printers. To copy
printer settings:

1 Type the printer IP address into the address field of your Web browser.

Note: If you do not know the IP address of the printer, then print a network setup page and locate the IP
address in the TCP/IP section.

2 Click Copy Printer Settings.

3 To change the language, select a language from the drop‑down list, and then click Click here to submit
language.

4 Click Printer Settings.

5 Enter the IP addresses of the source and target printers.

Note: To add additional target printers, click the Add Target IP button.

6 Click Copy Printer Settings.
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Troubleshooting

Solving basic printer problems
If there are basic printer problems, or the printer is unresponsive, make sure:

• The power cord is plugged into the printer and a properly grounded electrical outlet.

• The electrical outlet is not turned off by any switch or breaker.

• The Ground Fault Circuit Interrupter (GFCI) has not tripped.

• The printer is not plugged into any surge protectors, uninterrupted power supplies, or extension cords.

• Other electronic equipment plugged into the outlet is working.

• The printer is turned on. Check the printer power switch.

• The printer cable is securely attached to the printer and the host computer, print server, option, or other
network device.

• All options are properly installed.

• The printer driver settings are correct.

Once you have checked each of these possibilities, turn the printer off, wait for about 10 seconds, and then
turn the printer back on. This often fixes the problem.

Printer control panel display is blank or displays only
diamonds

The printer self test failed. Turn the printer off, wait about 10 seconds, and then turn the printer back on.

If Performing Self Test and Ready do not appear, turn the printer off and contact Customer Support.

Solving printing problems

Jobs do not print
These are possible solutions. Try one or more of the following:

Make sure the printer is ready to print

Make sure Ready or Power Saver appears on the display before sending a job to print.

Check to see if the standard exit bin is full

Remove the stack of paper from the standard exit bin.

Check to see if the tray is empty

Load paper in the tray.
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Make sure the correct printer software is installed

Verify that you installed the correct printer software for your printer model. Open the Software and
Documentation CD to check which software is installed. For more information, see “Installing printer
software” on page 23. Make sure the model number of the software matches the model number of your
printer.

To verify that the printer software is the most current, check the Lexmark Web site at www.lexmark.com.

Make sure the printer is connected to the network

Print a network setup page and check that the status shows Connected. If the status is Not Connected,
check the network cables, and then try printing the network setup page again. Contact your system support
person to make sure the network is functioning correctly.

Copies of the printer software are also available on the Lexmark Web site at www.lexmark.com.

Make sure you are using a recommended USB, parallel, or Ethernet cable

For more information, visit the Lexmark Web site at www.lexmark.com.

Make sure printer cables are securely connected

Check the cable connections to the printer to make sure they are secure. For more information, see the
setup documentation that came with the printer.

Multiple‑language PDFs do not print
The documents contain unavailable fonts.

1 Open the document you want to print in Adobe Acrobat.

2 Click the printer icon.

The Print dialog appears.

3 Select Print as image.

4 Click OK.

Job takes longer than expected to print
These are possible solutions. Try one or more of the following:

Reduce the complexity of the print job

Reduce the number and size of fonts, the number and complexity of images, and the number of pages in
the job.

Change the Page Protect setting to Off

1 From the printer control panel, press .

2 Press the arrow buttons until Settings appears, and then press .

3 Press the arrow buttons until General Settings appears, and then press .
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4 Press the arrow buttons until Print Recovery appears, and then press .

5 Press the arrow buttons until Page Protect appears, and then press .

6 Press the arrow buttons until Off appears, and then press .

Job prints from the wrong tray or on the wrong paper

Check the Paper Type setting

Make sure the Paper Type setting matches the paper loaded in the tray.

Incorrect characters print
Make sure the printer is not in Hex Trace mode. If Ready Hex appears on the display, you must exit Hex
Trace mode before you can print your job. Turn the printer off and back on to exit Hex Trace mode.

Tray linking does not work

Load the same size and type of paper in each tray

1 Load the same size and type of paper in each tray.

2 Move the paper guides to the correct positions for the paper size loaded in each tray.

Make sure the Paper Size and Paper Type settings are the same for each tray

1 Print a menu settings page and compare the settings for each tray.

2 If necessary, adjust the settings from the Paper Size/Type menu.

Note: None of the paper sources, trays, or feeders automatically sense the paper size. You must set the
size from the Paper Size/Type menu on the printer control panel or from the Embedded Web Server.

Large jobs do not collate
These are possible solutions. Try one or more of the following:

Make sure Collate is set to On

From Print Properties or the printer control panel Finishing menu, set Collate to On.

Note: Setting Collate to Off in the software overrides the setting in the Finishing menu.

Reduce the complexity of the print job

Reduce the complexity of the print job by reducing the number and size of fonts, the number and complexity
of images, and the number of pages in the job.
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Make sure the printer has enough memory

Add printer memory.

Unexpected page breaks occur
Increase the Print Timeout value:

1 From the printer control panel, press .

2 Press the arrow buttons until Settings appears, and then press .

3 Press the arrow buttons until General Settings appears, and then press .

4 Press the arrow buttons until Timeouts appears, and then press .

5 Press the arrow buttons until Print Timeout appears, and then press .

6 Press the arrow buttons until the value you want appears, and then press .

Solving option problems

Option does not operate correctly or quits after it is installed
These are possible solutions. Try one or more of the following:

Reset the printer

Turn the printer off, wait for about 10 seconds, and then turn the printer on.

Check to see if the option is connected to the printer

1 Turn the printer off.

2 Unplug the printer.

3 Check the connection between the option and the printer.

Make sure the option is installed

Print a menu settings page and check to see if the option is listed in the Installed Options list. If the option
is not listed, reinstall it.

Make sure the option is selected

From the program you are using, select the option. Mac OS 9 users should make sure the printer is set up
in the Chooser.
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Drawers
These are possible solutions. Try one or more of the following:

Make sure the paper is loaded correctly

1 Pull the tray completely out.

2 Check for paper jams or misfeeds.

3 Make sure the guides are aligned against the edges of the paper.

4 Insert the tray.

Reset the printer

Turn the printer off, wait about 10 seconds, and then turn the printer on.

Flash memory card
Make sure the flash memory card is securely connected to the printer system board.

Memory card
Make sure the memory card is securely connected to the printer system board.

Solving paper feed problems

Paper frequently jams
These are possible solutions. Try one or more of the following:

Check the paper

Use recommended paper and other specialty media. For more information, see “Paper and specialty media
guidelines” on page 41.

Make sure there is not too much paper in the tray or feeder

Make sure the stack of paper you load does not exceed the maximum stack height indicated in the tray or
on the multipurpose feeder.

Check the guides

Move the guides in the tray to the correct positions for the paper size loaded.

The paper absorbed moisture due to high humidity

• Load paper from a fresh package.

• Store paper in its original wrapper until you use it.
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Paper jam message remains after jam is cleared

The paper path is not clear. Clear jammed paper from the entire paper path, and then press .

Page that jammed does not reprint after you clear the jam
In the Settings menu, Jam Recovery is set to Off. Set Jam Recovery to Auto or On:

1 Press .

2 Press the arrow buttons until Settings appears, and then press .

3 Press the arrow buttons until General Settings appears, and then press .

4 Press the arrow buttons until Print Recovery appears, and then press .

5 Press the arrow buttons until Jam Recovery appears, and then press .

6 Press the arrow buttons until On or Auto appears, and then press .
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Solving print quality problems
The information in the following topics may help you solve print quality problems. If these suggestions still do
not correct the problem, then contact Customer Support. You may have a printer part that requires adjustment
or replacement.

Isolating print quality problems
To help isolate print quality problems, print the print quality test pages, but first make sure the standard tray
is loaded:

1 Turn the printer off.

2 Load letter‑ or A4‑size paper in the standard tray. Load the paper stack toward the back of the tray as
shown with the recommended print side facedown. Notice the maximum fill line on the side of the tray
to guide you. Do not overfill the tray.

Print the print quality test pages:

1 Turn the printer off.

2 From the printer control panel, hold down  and the right arrow button while turning the printer on.

3 Release the buttons when CONFIG MENU appears.

4 Press the arrow buttons until Prt Quality Pgs appears, and then press .

The print quality test pages print.

5 Press the arrow buttons until Exit Config Menu appears, and then press .

Resetting the Printer appears briefly, and then Ready appears.
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Blank pages

Try one or more of the following:

• Remove and reinstall the toner cartridge.

• Remove and reinstall the photoconductor kit.

If the printer still prints blank pages, it may need to be serviced. For more information, contact Customer
Support.

Characters have jagged or uneven edges

If you are using downloaded fonts, verify that the fonts are supported by the printer, the host computer, and
the software program.

Clipped images
These are possible solutions. Try one or more of the following:

Check the guides

Move the width and length guides in the tray to the correct positions for the paper size loaded.

Check the Paper Size setting

Make sure the Paper Size setting matches the paper loaded in the tray.
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Gray background

• For Windows users: From Print Properties, select a different Toner Darkness setting before sending the
job to print.

• For Macintosh users: From the print options, Copies & Pages, or General pop‑up menu, choose Printer
Features, and then choose the setting needed from the Toner Darkness pop‑up menu.

• From the printer control panel Quality menu, select a different Toner Darkness setting before sending
the job to print.

Ghost images

These are possible solutions. Try one or more of the following:

The photoconductor kit is defective

Replace the photoconductor kit.

Check the Media Type setting

• For Windows users: From Print Properties, make sure the Media Type setting matches the paper loaded
in the tray.

• For Macintosh users: From the Print dialog, make sure the Paper Type setting matches the paper loaded
in the tray.

• From the printer control panel Paper menu, make sure the Paper Type setting matches the paper loaded
in the tray.
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Incorrect margins

These are possible solutions. Try one or more of the following:

Check the guides

Move the width and length guides in the tray to the correct positions for the paper size loaded.

Check the Paper Size setting

Make sure the Paper Size setting matches the paper loaded in the tray.

Check the Page size setting

Before sending the job to print, specify the correct page size in Print Properties, the Print dialog, or the
software program.

Paper curl
These are possible solutions. Try one or more of the following:

Check the Paper Type setting

• For Windows users: From Print Properties, make sure the Media Type setting matches the paper loaded
in the tray.

• For Macintosh users: From the Print dialog, make sure the Paper Type setting matches the paper loaded
in the tray.

• From the printer control panel Paper menu, make sure the Paper Type setting matches the paper loaded
in the tray.

The paper has absorbed moisture due to high humidity

• Load paper from a fresh package.

• Store paper in its original wrapper until you use it.
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Print is too dark

These are possible solutions. Try one or more of the following:

Check the darkness, brightness, and contrast settings

The Toner Darkness setting is too dark, the Brightness setting is too dark, or the Contrast setting is too high.

• For Windows users: From Print Properties, change these settings.

• For Macintosh users:

1 Choose File > Print.

2 Locate the drop‑down box under the Orientation pictures, and then click the down button.

3 Click Printer Features.

4 Change the settings for Toner Darkness, Brightness, and Contrast.

• From the printer control panel Quality menu, change these settings.

The paper has absorbed moisture due to high humidity

• Load paper from a fresh package.

• Store paper in its original wrapper until you use it.

Check the paper

Avoid textured paper with rough finishes.

Check the Paper Type setting

• For Windows users: From Print Properties, make sure the Media Type setting matches the paper loaded
in the tray.

• For Macintosh users: From the Print dialog, make sure the Paper Type setting matches the paper loaded
in the tray.

• From the printer control panel Paper menu, make sure the Paper Type setting matches the paper loaded
in the tray.

The toner cartridge may be defective

Replace the toner cartridge.

Troubleshooting 125



Print is too light

These are possible solutions. Try one or more of the following:

Check the darkness, brightness, and contrast settings

The Toner Darkness setting is too light, the Brightness setting is too light, or the Contrast setting is too low.

• For Windows users: From Print Properties, change these settings.

• For Macintosh users:

1 Choose File > Print.

2 Locate the drop‑down box under the Orientation pictures, and then click the down button.

3 Click Printer Features.

4 Change the settings for Toner Darkness, Brightness, and Contrast.

• From the printer control panel Quality menu, change these settings.

The paper has absorbed moisture due to high humidity

• Load paper from a fresh package.

• Store paper in its original wrapper until you use it.

Check the paper

Avoid textured paper with rough finishes.

Check the Paper Type setting

• For Windows users: From Print Properties, make sure the Media Type setting matches the paper loaded
in the tray.

• For Macintosh users: From the Print dialog, make sure the Paper Type setting matches the paper loaded
in the tray.

• From the printer control panel Paper menu, make sure the Paper Type setting matches the paper loaded
in the tray.

The toner is low

When 88 Cartridge low appears, order a new toner cartridge.

The toner cartridge may be defective

Replace the toner cartridge.
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Skewed print

Check the paper guides

Move the guides in the tray to the correct positions for the paper size loaded.

Check the paper

Make sure you are using paper that meets the printer specifications.

Toner fog or background shading appears on the page
These are possible solutions. Try one or more of the following:

The toner cartridge may be defective

Replace the toner cartridge.

There is toner in the paper path

Contact Customer Support.

Toner rubs off

These are possible solutions. Try one or more of the following:

Check the Paper Type setting

Make sure the Paper Type setting matches the paper loaded in the tray.

Check the Paper Texture setting

Make sure the Paper Texture setting matches the paper loaded in the tray.
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Toner specks

These are possible solutions. Try one or more of the following:

The toner cartridge may be defective

Replace the toner cartridge.

There is toner in the paper path

Contact Customer Support.

Transparency print quality is poor

Check the transparencies

Use only transparencies recommended by the printer manufacturer.

Check the Paper Type setting

Load transparencies, and make sure the Paper Type setting is set to Transparency.

Streaked horizontal lines

These are possible solutions. Try one or more of the following:

The toner may smear when paper is fed from a specific source

From Print Properties, the print dialog, or the printer control panel, select another tray or feeder to feed the
paper for the job.

The toner cartridge may be defective

Replace the toner cartridge.
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Make sure the paper path is clear

Paper could be caught between the photoconductor kit and the fuser. Check the paper path around the
fuser area.

CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from
a hot component, allow the surface to cool before touching.

Clear any paper you see.

There may be excess toner in the paper path

Contact Customer Support.

Streaked vertical lines

These are possible solutions. Try one or more of the following:

The toner may smear when paper is fed from a specific source

From Print Properties, the Print dialog, or the printer control panel, select another tray or feeder to feed
paper for the job.

The toner cartridge is defective

Replace the toner cartridge.

Make sure the paper path is clear

Paper could be caught between the photoconductor kit and the fuser. Check the paper path around the
fuser area.

Warning—Potential Damage: Do not touch the photoconductor on the underside of the
photoconductor kit. Use the cartridge handle whenever you are holding the cartridge.

CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from
a hot component, allow the surface to cool before touching.

Clear any paper you see.

There may be excess toner in the paper path

Contact Customer Support.
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Solid black or white streaks appear on transparencies or paper

These are possible solutions. Try one or more of the following:

Make sure the fill pattern is correct

If the fill pattern is incorrect, choose a different fill pattern from your software program.

Check the paper type

• Try a different type of paper.

• For transparencies, use only ones recommended by the printer manufacturer.

• Make sure the Paper Type setting matches what is loaded in the tray or feeder.

• Make sure the Paper Texture setting is correct for the type of paper or specialty media loaded in the
tray or feeder.

Make sure the toner is distributed evenly in the toner cartridge

Remove the toner cartridge and shake it from side to side to redistribute the toner to extend the life of the
cartridge, and then reinstall it.

The toner cartridge may be defective or low on toner

Replace the used toner cartridge with a new one.

Embedded Web Server does not open
These are possible solutions. Try one or more of the following:

Check the network connections

Make sure the printer and computer are turned on and connected to the same network.

Check the network settings

Depending on the network settings, you may need to type https:// instead of http:// before the printer
IP address to access the Embedded Web Server. For more information, see your system administrator.
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Contacting Customer Support
When you call Customer Support, describe the problem you are experiencing, the message on the display,
and the troubleshooting steps you have already taken to find a solution.

You need to know your printer model type and serial number. For more information, see the label on the
inside top front cover of the printer. The serial number is also listed on the menu settings page.

In the U.S. or Canada, call (1‑800‑539‑6275). For other countries/regions, visit the Lexmark Web site at
www.lexmark.com.
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Notices

Product information
Product name:

Lexmark E360d and E360dn

Machine type:

4513

Model(s):

420, 430

Machine type:

4549

d01, d02, gd1, gd2

Machine type:

4564

dn1, dn2, gd1, gd2

Edition notice
May 2008

The following paragraph does not apply to any country where such provisions are inconsistent with local
law: LEXMARK INTERNATIONAL, INC., PROVIDES THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY
KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of
express or implied warranties in certain transactions; therefore, this statement may not apply to you.

This publication could include technical inaccuracies or typographical errors. Changes are periodically made
to the information herein; these changes will be incorporated in later editions. Improvements or changes in the
products or the programs described may be made at any time.

References in this publication to products, programs, or services do not imply that the manufacturer intends to
make these available in all countries in which it operates. Any reference to a product, program, or service is
not intended to state or imply that only that product, program, or service may be used. Any functionally
equivalent product, program, or service that does not infringe any existing intellectual property right may be
used instead. Evaluation and verification of operation in conjunction with other products, programs, or services,
except those expressly designated by the manufacturer, are the user’s responsibility.

For Lexmark technical support, visit support.lexmark.com.

For information on supplies and downloads, visit www.lexmark.com.
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If you don't have access to the Internet, you can contact Lexmark by mail:

Lexmark International, Inc.
Bldg 004-2/CSC
740 New Circle Road NW
Lexington, KY 40550
USA

© 2008 Lexmark International, Inc.

All rights reserved.

UNITED STATES GOVERNMENT RIGHTS
This software and any accompanying documentation provided under this agreement are commercial computer
software and documentation developed exclusively at private expense.

Trademarks
Lexmark and Lexmark with diamond design are trademarks of Lexmark International, Inc., registered in the
United States and/or other countries.

PCL® is a registered trademark of the Hewlett-Packard Company.

All other trademarks are the property of their respective owners.

Federal Communications Commission (FCC) compliance information

statement
This product has been tested and found to comply with the limits for a Class B digital device, pursuant to Part
15 of the FCC Rules. Operation is subject to the following two conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.

The FCC Class B limits are designed to provide reasonable protection against harmful interference when the
equipment is operated in a residential installation. This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio communications. However, there is no guarantee that interference will not occur in a
particular installation. If this equipment does cause harmful interference to radio or television reception, which
can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference
by one or more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

• Consult your point of purchase or service representative for additional suggestions.

The manufacturer is not responsible for radio or television interference caused by using other than
recommended cables or by unauthorized changes or modifications to this equipment. Unauthorized changes
or modifications could void the user's authority to operate this equipment.

Note: To assure compliance with FCC regulations on electromagnetic interference for a Class B computing
device, use a properly shielded and grounded cable such as Lexmark part number 1021231 for parallel attach
or 1021294 for USB attach. Use of a substitute cable not properly shielded and grounded may result in a
violation of FCC regulations.
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Any questions regarding this compliance information statement should be directed to:

Director of Lexmark Technology & Services
Lexmark International, Inc.
740 West New Circle Road
Lexington, KY 40550
(859) 232–3000

Industry Canada compliance statement
This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment
Standard ICES-003.

Avis de conformité aux normes de l’industrie du Canada
Cet appareil numérique de classe B est conforme aux exigences de la norme canadienne relative aux
équipements pouvant causer des interférences NMB-003.

European Community (EC) directives conformity
This product is in conformity with the protection requirements of EC Council directives 2004/108/EC and
2006/95/EC on the approximation and harmonization of the laws of the Member States relating to
electromagnetic compatibility and safety of electrical equipment designed for use within certain voltage limits.

A declaration of conformity with the requirements of the directives has been signed by the Director of
Manufacturing and Technical Support, Lexmark International, Inc., S.A., Boigny, France.

This product satisfies the Class B limits of EN 55022 and safety requirements of EN 60950.

The following notices are applicable if your printer has a wireless network card installed

Exposure to radio frequency radiation
The radiated output power of this device is far below the radio frequency exposure limits of the FCC and other
regulatory agencies. A minimum separation of 20 cm (8 inches) must be maintained between the antenna and
any persons for this device to satisfy the RF exposure requirements of the FCC and other regulatory agencies.

Industry Canada notice
The following notices are applicable if your printer has a wireless network card installed.

Industry Canada (Canada)

This device complies with Industry Canada specification RSS-210. Operation is subject to the following two
conditions: (1) this device may not cause interference, and (2) this device must accept any interference, including
interference that may cause undesired operation of the device.

This device has been designed to operate only with the antenna provided. Use of any other antenna is strictly
prohibited per regulations of Industry Canada.

To prevent radio interference to the licensed service, this device is intended to be operated indoors and away
from windows to provide maximum shielding. Equipment (or its transmit antenna) that is installed outdoors is
subject to licensing.
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The installer of this radio equipment must ensure that the antenna is located or pointed such that it does not
emit RF fields in excess of Health Canada limits for the general population; consult Safety Code 6, obtainable
from Health Canada's Web site www.hc-sc.gc.ca/rpb.

The term "IC:" before the certification/registration number only signifies that the Industry Canada technical
specifications were met.

Industry Canada (Canada)

Cet appareil est conforme à la norme RSS-210 d'Industry Canada. Son fonctionnement est soumis aux deux
conditions suivantes :

(1) cet appareil ne doit pas provoquer d'interférences et (2) il doit accepter toute interférence reçue, y compris
celles risquant d'altérer son fonctionnement.

Cet appareil a été conçu pour fonctionner uniquement avec l'antenne fournie. L'utilisation de toute autre
antenne est strictement interdite par la réglementation d'Industry Canada.

En application des réglementations d'Industry Canada, l'utilisation d'une antenne de gain supérieur est
strictement interdite.

Pour empêcher toute interférence radio au service faisant l'objet d'une licence, cet appareil doit être utilisé à
l'intérieur et loin des fenêtres afin de garantir une protection optimale.

Si le matériel (ou son antenne d'émission) est installé à l'extérieur, il doit faire l'objet d'une licence.

L'installateur de cet équipement radio doit veiller à ce que l'antenne soit implantée et dirigée de manière à
n'émettre aucun champ HF dépassant les limites fixées pour l'ensemble de la population par Santé Canada.
Reportez-vous au Code de sécurité 6 que vous pouvez consulter sur le site Web de Santé Canada www.hc-
sc.gc.ca/rpb.

Le terme « IC » précédant le numéro de d'accréditation/inscription signifie simplement que le produit est
conforme aux spécifications techniques d'Industry Canada.

European Community (EC) directives conformity statement for radio

products
This product is in conformity with the protection requirements of EC Council directives 2004/108/EC,
2006/95/EC, and 1999/5/EC on the approximation and harmonization of the laws of the Member States relating
to electromagnetic compatibility, safety of electrical equipment designed for use within certain voltage limits
and on radio equipment and telecommunications terminal equipment.

Compliance is indicated by the CE marking.

Operation is allowed in all EU and EFTA countries, but is restricted to indoor use only.

A declaration of conformity with the requirements of the directives is available from the Director of
Manufacturing and Technical Support, Lexmark International, S. A., Boigny, France.

This product satisfies the limits of EN 55022; safety requirements of EN 60950; radio spectrum requirements
of ETSI EN 300 328; and the EMC requirements of EN 55024, ETSI EN 301 489-1 and ETSI EN 301 489-17.
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Česky Společnost Lexmark International, Inc. tímto prohlašuje, že výrobek tento výrobek je ve shodě se
základními požadavky a dalšími příslušnými ustanoveními směrnice 1999/5/ES.

Dansk Lexmark International, Inc. erklærer herved, at dette produkt overholder de væsentlige krav og øvrige
relevante krav i direktiv 1999/5/EF.

Deutsch Hiermit erklärt Lexmark International, Inc., dass sich das Gerät dieses Gerät in Übereinstimmung mit
den grundlegenden Anforderungen und den übrigen einschlägigen Bestimmungen der Richtlinie
1999/5/EG befindet.

Ελληνική ΜΕ ΤΗΝ ΠΑΡΟΥΣΑ Η LEXMARK INTERNATIONAL, INC. ΔΗΛΩΝΕΙ ΟΤΙ ΑΥΤΟ ΤΟ ΠΡΟΪΟΝ
ΣΥΜΜΟΡΦΩΝΕΤΑΙ ΠΡΟΣ ΤΙΣ ΟΥΣΙΩΔΕΙΣ ΑΠΑΙΤΗΣΕΙΣ ΚΑΙ ΤΙΣ ΛΟΙΠΕΣ ΣΧΕΤΙΚΕΣ ΔΙΑΤΑΞΕΙΣ
ΤΗΣ ΟΔΗΓΙΑΣ 1999/5/ΕΚ.

English Hereby, Lexmark International, Inc., declares that this type of equipment is in compliance with the
essential requirements and other relevant provisions of Directive 1999/5/EC.

Español Por medio de la presente, Lexmark International, Inc. declara que este producto cumple con los
requisitos esenciales y cualesquiera otras disposiciones aplicables o exigibles de la Directiva
1999/5/CE.

Eesti Käesolevaga kinnitab Lexmark International, Inc., et seade see toode vastab direktiivi 1999/5/EÜ
põhinõuetele ja nimetatud direktiivist tulenevatele muudele asjakohastele sätetele.

Suomi Lexmark International, Inc. vakuuttaa täten, että tämä tuote on direktiivin 1999/5/EY oleellisten
vaatimusten ja muiden sitä koskevien direktiivin ehtojen mukainen.

Français Par la présente, Lexmark International, Inc. déclare que l'appareil ce produit est conforme aux
exigences fondamentales et autres dispositions pertinentes de la directive 1999/5/CE.

Magyar Alulírott, Lexmark International, Inc. nyilatkozom, hogy a termék megfelel a vonatkozó alapvetõ
követelményeknek és az 1999/5/EC irányelv egyéb elõírásainak.

Íslenska Hér með lýsir Lexmark International, Inc. yfir því að þessi vara er í samræmi við grunnkröfur og aðrar
kröfur, sem gerðar eru í tilskipun 1999/5/EC.

Italiano Con la presente Lexmark International, Inc. dichiara che questo questo prodotto è conforme ai requisiti
essenziali ed alle altre disposizioni pertinenti stabilite dalla direttiva 1999/5/CE.

Latviski Ar šo Lexmark International, Inc. deklarē, ka šis izstrādājums atbilst Direktīvas 1999/5/EK būtiskajām
prasībām un citiem ar to saistītajiem noteikumiem.

Lietuvių Šiuo Lexmark International, Inc. deklaruoja, kad šis produktas atitinka esminius reikalavimus ir kitas
1999/5/EB direktyvos nuostatas.

Malti Bil-preżenti, Lexmark International, Inc., jiddikjara li dan il-prodott huwa konformi mal-ħtiġijiet
essenzjali u ma dispożizzjonijiet oħrajn relevanti li jinsabu fid-Direttiva 1999/5/KE.

Nederlands Hierbij verklaart Lexmark International, Inc. dat het toestel dit product in overeenstemming is met de
essentiële eisen en de andere relevante bepalingen van richtlijn 1999/5/EG.

Norsk Lexmark International, Inc. erklærer herved at dette produktet er i samsvar med de grunnleggende
krav og øvrige relevante krav i direktiv 1999/5/EF.

Polski Niniejszym Lexmark International, Inc. oświadcza, że niniejszy produkt jest zgodny z zasadniczymi
wymogami oraz pozostałymi stosownymi postanowieniami Dyrektywy 1999/5/EC.

Português A Lexmark International Inc. declara que este este produto está conforme com os requisitos essenciais
e outras disposições da Diretiva 1999/5/CE.

Slovensky Lexmark International, Inc. týmto vyhlasuje, že tento produkt spĺňa základné požiadavky a všetky
príslušné ustanovenia smernice 1999/5/ES.
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Slovensko Lexmark International, Inc. izjavlja, da je ta izdelek v skladu z bistvenimi zahtevami in ostalimi
relevantnimi določili direktive 1999/5/ES.

Svenska Härmed intygar Lexmark International, Inc. att denna produkt står i överensstämmelse med de
väsentliga egenskapskrav och övriga relevanta bestämmelser som framgår av direktiv 1999/5/EG.

Noise emission levels
The following measurements were made in accordance with ISO 7779 and reported in conformance with ISO
9296.

Note: Some modes may not apply to your product.

1-meter average sound pressure, dBA

Printing 53 dBA

Ready N/A

Values are subject to change. See www.lexmark.com for current values.

Waste from Electrical and Electronic Equipment (WEEE) directive

The WEEE logo signifies specific recycling programs and procedures for electronic products in countries of the
European Union. We encourage the recycling of our products. If you have further questions about recycling
options, visit the Lexmark Web site at www.lexmark.com for your local sales office phone number.

Static sensitivity notice

This symbol identifies static-sensitive parts. Do not touch in the areas near these symbols without first touching
the metal frame of the printer.
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ENERGY STAR

Laser notice
The printer is certified in the U.S. to conform to the requirements of DHHS 21 CFR Subchapter J for Class I (1)
laser products, and elsewhere is certified as a Class I laser product conforming to the requirements of IEC
60825-1.

Class I laser products are not considered to be hazardous. The printer contains internally a Class IIIb (3b) laser
that is nominally a 7 milliwatt gallium arsenide laser operating in the wavelength of 655-675 nanometers. The
laser system and printer are designed so there is never any human access to laser radiation above a Class I
level during normal operation, user maintenance, or prescribed service condition.

Laser advisory label
A laser notice label may be affixed to this printer as shown:

Power consumption

Product power consumption

The following table documents the power consumption characteristics of the product.

Note: Some modes may not apply to your product.

Mode Description Power consumption
(Watts)

Printing The product is generating hard‑copy output from electronic inputs. 500

Copying The product is generating hard‑copy output from hard‑copy original
documents.

NA

Scanning The product is scanning hard‑copy documents. NA

Ready The product is waiting for a print job. 12

Power Saver The product is in energy‑saving mode. 11

Off The product is plugged into a wall outlet, but the power switch is turned off. NA

The power consumption levels listed in the previous table represent time-averaged measurements.
Instantaneous power draws may be substantially higher than the average.

Values are subject to change. See www.lexmark.com for current values.
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Power Saver

This product is designed with an energy-saving mode called Power Saver. The Power Saver Mode is equivalent
to the EPA Sleep Mode. The Power Saver Mode saves energy by lowering power consumption during extended
periods of inactivity. The Power Saver Mode is automatically engaged after this product is not used for a
specified period of time, called the Power Saver Timeout.

Factory default Power Saver Timeout for this product (in minutes): 30

By using the configuration menus, the Power Saver Timeout can be modified between 1 minute and 240
minutes. Setting the Power Saver Timeout to a low value reduces energy consumption, but may increase the
response time of the product. Setting the Power Saver Timeout to a high value maintains a fast response, but
uses more energy.

Off mode

If this product has an off mode which still consumes a small amount of power, then to completely stop product
power consumption, disconnect the power supply cord from the wall outlet.

Total energy usage

It is sometimes helpful to calculate the total product energy usage. Since power consumption claims are
provided in power units of Watts, the power consumption should be multiplied by the time the product spends
in each mode in order to calculate energy usage. The total product energy usage is the sum of each mode's
energy usage.

Statement of Limited Warranty
Lexmark E360d and E360dn

Lexmark International, Inc., Lexington, KY

This limited warranty applies to the United States and Canada. For customers outside the U.S., refer to the
country-specific warranty information that came with your product.

This limited warranty applies to this product only if it was originally purchased for your use, and not for resale,
from Lexmark or a Lexmark Remarketer, referred to in this statement as “Remarketer.”

Limited warranty

Lexmark warrants that this product:

—Is manufactured from new parts, or new and serviceable used parts, which perform like new parts

—Is, during normal use, free from defects in material and workmanship

If this product does not function as warranted during the warranty period, contact a Remarketer or Lexmark for
repair or replacement (at Lexmark's option).

If this product is a feature or option, this statement applies only when that feature or option is used with the
product for which it was intended. To obtain warranty service, you may be required to present the feature or
option with the product.

If you transfer this product to another user, warranty service under the terms of this statement is available to
that user for the remainder of the warranty period. You should transfer proof of original purchase and this
statement to that user.
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Limited warranty service

The warranty period starts on the date of original purchase as shown on the purchase receipt and ends 12
months later provided that the warranty period for any supplies and for any maintenance items included with
the printer shall end earlier if it, or its original contents, are substantially used up, depleted, or consumed.

To obtain warranty service you may be required to present proof of original purchase. You may be required to
deliver your product to the Remarketer or Lexmark, or ship it prepaid and suitably packaged to a Lexmark
designated location. You are responsible for loss of, or damage to, a product in transit to the Remarketer or the
Lexmark designated location.

When warranty service involves the exchange of a product or part, the item replaced becomes the property of
the Remarketer or Lexmark. The replacement may be a new or repaired item.

The replacement item assumes the remaining warranty period of the original product.

Replacement is not available to you if the product you present for exchange is defaced, altered, in need of a
repair not included in warranty service, damaged beyond repair, or if the product is not free of all legal
obligations, restrictions, liens, and encumbrances.

Before you present this product for warranty service, remove all print cartridges, programs, data, and removable
storage media (unless directed otherwise by Lexmark).

For further explanation of your warranty alternatives and the nearest Lexmark authorized servicer in your area
contact Lexmark on the World Wide Web at www.lexmark.com/support.

Remote technical support is provided for this product throughout its warranty period. For products no longer
covered by a Lexmark warranty, technical support may not be available or only be available for a fee.

Extent of limited warranty

Lexmark does not warrant uninterrupted or error-free operation of any product or the durability or longevity of
prints produced by any product.

Warranty service does not include repair of failures caused by:

—Modification or unauthorized attachments

—Accidents, misuse, abuse or use inconsistent with Lexmark user’s guides, manuals, instructions or guidance

—Unsuitable physical or operating environment

—Maintenance by anyone other than Lexmark or a Lexmark authorized servicer

—Operation of a product beyond the limit of its duty cycle

—Use of printing media outside of Lexmark specifications

—Refurbishment, repair, refilling or remanufacture by a third party of products, supplies or parts

—Products, supplies, parts, materials (such as toners and inks), software, or interfaces not furnished by Lexmark

TO THE EXTENT PERMITTED BY APPLICABLE LAW, NEITHER LEXMARK NOR ITS THIRD PARTY SUPPLIERS
OR REMARKETERS MAKE ANY OTHER WARRANTY OR CONDITION OF ANY KIND, WHETHER EXPRESS
OR IMPLIED, WITH RESPECT TO THIS PRODUCT, AND SPECIFICALLY DISCLAIM THE IMPLIED
WARRANTIES OR CONDITIONS OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND
SATISFACTORY QUALITY. ANY WARRANTIES THAT MAY NOT BE DISCLAIMED UNDER APPLICABLE LAW
ARE LIMITED IN DURATION TO THE WARRANTY PERIOD. NO WARRANTIES, EXPRESS OR IMPLIED, WILL
APPLY AFTER THIS PERIOD. ALL INFORMATION, SPECIFICATIONS, PRICES, AND SERVICES ARE SUBJECT
TO CHANGE AT ANY TIME WITHOUT NOTICE.
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Limitation of liability

Your sole remedy under this limited warranty is set forth in this document. For any claim concerning performance
or nonperformance of Lexmark or a Remarketer for this product under this limited warranty, you may recover
actual damages up to the limit set forth in the following paragraph.

Lexmark's liability for actual damages from any cause whatsoever will be limited to the amount you paid for the
product that caused the damages. This limitation of liability will not apply to claims by you for bodily injury or
damage to real property or tangible personal property for which Lexmark is legally liable. IN NO EVENT WILL
LEXMARK BE LIABLE FOR ANY LOST PROFITS, LOST SAVINGS, INCIDENTAL DAMAGE, OR OTHER
ECONOMIC OR CONSEQUENTIAL DAMAGES. This is true even if you advise Lexmark or a Remarketer of the
possibility of such damages. Lexmark is not liable for any claim by you based on a third party claim.

This limitation of remedies also applies to claims against any Suppliers and Remarketers of Lexmark. Lexmark's
and its Suppliers' and Remarketers' limitations of remedies are not cumulative. Such Suppliers and Remarketers
are intended beneficiaries of this limitation.

Additional rights

Some states do not allow limitations on how long an implied warranty lasts, or do not allow the exclusion or
limitation of incidental or consequential damages, so the limitations or exclusions contained above may not
apply to you.

This limited warranty gives you specific legal rights. You may also have other rights that vary from state to state.

LEXMARK SOFTWARE LIMITED WARRANTY AND LICENSE AGREEMENT
PLEASE READ CAREFULLY BEFORE USING THIS PRODUCT: This License Agreement (“Software License
Agreement”) is a legal agreement between you (either an individual or a single entity) and Lexmark International,
Inc. (“Lexmark”) that, to the extent your Lexmark product or Software Program is not otherwise subject to a
written software license agreement between you and Lexmark or its suppliers, governs your use of any Software
Program installed on or provided by Lexmark for use in connection with your Lexmark product. The term
“Software Program” includes machine-readable instructions, audio/visual content (such as images and
recordings), and associated media, printed materials and electronic documentation, whether incorporated into,
distributed with or for use with your Lexmark product.

BY USING THIS PRODUCT, YOU AGREE TO BE BOUND BY ALL THE TERMS AND CONDITIONS OF THIS
SOFTWARE LIMITED WARRANTY AND LICENSE AGREEMENT. IF YOU DO NOT AGREE WITH THE TERMS OF
THIS SOFTWARE LIMITED WARRANTY AND LICENSE AGREEMENT, PROMPTLY RETURN THE PRODUCT
UNUSED AND REQUEST A REFUND OF THE AMOUNT YOU PAID. IF YOU ARE INSTALLING THIS PRODUCT
FOR USE BY OTHER PARTIES, YOU AGREE TO INFORM THE USERS THAT USE OF THE PRODUCT INDICATES
ACCEPTANCE OF THESE TERMS.

1 STATEMENT OF SOFTWARE LIMITED WARRANTY. Lexmark warrants that the media (e.g., diskette or
compact disk) on which the Software Program (if any) is furnished is free from defects in materials and
workmanship under normal use during the warranty period. The warranty period is ninety (90) days and
commences on the date the Software Program is delivered to the original end-user. This limited warranty
applies only to Software Program media purchased new from Lexmark or an Authorized Lexmark Reseller
or Distributor. Lexmark will replace the Software Program should it be determined that the media does not
conform to this limited warranty.

2 DISCLAIMER AND LIMITATION OF WARRANTIES. EXCEPT AS PROVIDED IN THIS SOFTWARE LICENSE
AGREEMENT AND TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, LEXMARK AND ITS
SUPPLIERS PROVIDE THE SOFTWARE PROGRAM "AS IS" AND HEREBY DISCLAIM ALL OTHER
WARRANTIES AND CONDITIONS, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, TITLE,
NON-INFRINGEMENT, MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, AND ABSENCE
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OF VIRUSES, ALL WITH REGARD TO THE SOFTWARE PROGRAM. TO THE EXTENT LEXMARK CANNOT
BY LAW DISCLAIM ANY COMPONENT OF THE IMPLIED WARRATIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE, LEXMARK LIMITS THE DURATION OF SUCH WARRANTIES TO THE 90-
DAY TERM OF THE EXPRESS SOFTWARE LIMITED WARRANTY.

This Agreement is to be read in conjunction with certain statutory provisions, as that may be in force from
time to time, that imply warranties or conditions or impose obligations on Lexmark that cannot be excluded
or modified. If any such provisions apply, then to the extent Lexmark is able, Lexmark hereby limits its liability
for breach of those provisions to one of the following: providing you a replacement copy of the Software
Program or reimbursement of the price paid for the Software Program.

The Software Program may include internet links to other software applications and/or internet web pages
hosted and operated by third parties unaffiliated with Lexmark. You acknowledge and agree that Lexmark
is not responsible in any way for the hosting, performance, operation, maintenance, or content of, such
software applications and/or internet web pages.

3 LIMITATION OF REMEDY. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, ANY AND ALL
LIABILITY OF LEXMARK UNDER THIS SOFTWARE LICENSE AGREEMENT IS EXPRESSLY LIMITED TO THE
GREATER OF THE PRICE PAID FOR THE SOFTWARE PROGRAM AND FIVE U.S. DOLLARS (OR THE
EQUIVALENT IN LOCAL CURRENCY). YOUR SOLE REMEDY AGAINST LEXMARK IN ANY DISPUTE UNDER
THIS SOFTWARE LICENSE AGREEMENT SHALL BE TO SEEK TO RECOVER ONE OF THESE AMOUNTS,
UPON PAYMENT OF WHICH LEXMARK SHALL BE RELEASED AND DISCHARGED OF ALL FURTHER
OBLIGATIONS AND LIABILITY TO YOU.

IN NO EVENT WILL LEXMARK, ITS SUPPLIERS, SUBSIDIARIES, OR RESELLERS BE LIABLE FOR ANY
SPECIAL, INCIDENTAL, INDIRECT, EXEMPLARY, PUNITIVE, OR CONSEQUENTIAL DAMAGES (INCLUDING
BUT NOT LIMITED TO LOST PROFITS OR REVENUES, LOST SAVINGS, INTERRUPTION OF USE OR ANY
LOSS OF, INACCURACY IN, OR DAMAGE TO, DATA OR RECORDS, FOR CLAIMS OF THIRD PARTIES, OR
DAMAGE TO REAL OR TANGIBLE PROPERTY, FOR LOSS OF PRIVACY ARISING OUT OR IN ANY WAY
RELATED TO THE USE OF OR INABILITY TO USE THE SOFTWARE PROGRAM, OR OTHERWISE IN
CONNECTION WITH ANY PROVISION OF THIS SOFTWARE LICENCE AGREEMENT), REGARDLESS OF THE
NATURE OF THE CLAIM, INCLUDING BUT NOT LIMITED TO BREACH OF WARRANTY OR CONTRACT, TORT
(INCLUDING NEGLIGENCE OR STRICT LIABILITY), AND EVEN IF LEXMARK, OR ITS SUPPLIERS, AFFILIATES,
OR REMARKETERS HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR FOR ANY CLAIM
BY YOU BASED ON A THIRD-PARTY CLAIM, EXCEPT TO THE EXTENT THIS EXCLUSION OF DAMAGES IS
DETERMINED LEGALLY INVALID. THE FOREGOING LIMITATIONS APPLY EVEN IF THE ABOVE-STATED
REMEDIES FAIL OF THEIR ESSENTIAL PURPOSE.

4 U.S.A. STATE LAWS. This Software Limited Warranty gives you specific legal rights. You may also have other
rights that vary from state to state. Some states do not allow limitations on how long an implied warranty
lasts or the exclusion of limitation of incidental or consequential damages, so the above limitations may not
apply to you.

5 LICENSE GRANT. Lexmark grants you the following rights provided you comply with all terms and conditions
of this Software License Agreement:

a Use. You may Use one (1) copy of the Software Program. The term “Use” means storing, loading, installing,
executing, or displaying the Software Program. If Lexmark has licensed the Software Program to you for
concurrent use, you must limit the number of authorized users to the number specified in your agreement
with Lexmark. You may not separate the components of the Software Program for use on more than one
computer. You agree that you will not Use the Software Program, in whole or in part, in any manner that
has the effect of overriding, modifying, eliminating, obscuring, altering or de-emphasizing the visual
appearance of any trademark, trade name, trade dress or intellectual property notice that appears on
any computer display screens normally generated by, or as a result of, the Software Program.

b Copying. You may make one (1) copy of the Software Program solely for purposes of backup, archiving,
or installation, provided the copy contains all of the original Software Program’s proprietary notices. You
may not copy the Software Program to any public or distributed network.
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c Reservation of Rights. The Software Program, including all fonts, is copyrighted and owned by Lexmark
International, Inc. and/or its suppliers. Lexmark reserves all rights not expressly granted to you in this
Software License Agreement.

d Freeware. Notwithstanding the terms and conditions of this Software License Agreement, all or any
portion of the Software Program that constitutes software provided under public license by third parties
(“Freeware”) is licensed to you subject to the terms and conditions of the software license agreement
accompanying such Freeware, whether in the form of a discrete agreement, shrink-wrap license, or
electronic license terms at the time of download or installation. Use of the Freeware by you shall be
governed entirely by the terms and conditions of such license.

6 TRANSFER. You may transfer the Software Program to another end-user. Any transfer must include all
software components, media, printed materials, and this Software License Agreement and you may not
retain copies of the Software Program or components thereof. The transfer may not be an indirect transfer,
such as a consignment. Prior to the transfer, the end-user receiving the transferred Software Program must
agree to all these Software License Agreement terms. Upon transfer of the Software Program, your license
is automatically terminated. You may not rent, sublicense, or assign the Software Program except to the
extent provided in this Software License Agreement.

7 UPGRADES. To Use a Software Program identified as an upgrade, you must first be licensed to the original
Software Program identified by Lexmark as eligible for the upgrade. After upgrading, you may no longer
use the original Software Program that formed the basis for your upgrade eligibility.

8 LIMITATION ON REVERSE ENGINEERING. You may not alter, decrypt, reverse engineer, reverse assemble,
reverse compile or otherwise translate the Software Program or assist or otherwise facilitate others to do
so, except as and to the extent expressly permitted to do so by applicable law for the purposes of inter-
operability, error correction, and security testing. If you have such statutory rights, you will notify Lexmark
in writing of any intended reverse engineering, reverse assembly, or reverse compilation. You may not
decrypt the Software Program unless necessary for the legitimate Use of the Software Program.

9 ADDITIONAL SOFTWARE. This Software License Agreement applies to updates or supplements to the
original Software Program provided by Lexmark unless Lexmark provides other terms along with the update
or supplement.

10 TERM. This Software License Agreement is effective unless terminated or rejected. You may reject or
terminate this license at any time by destroying all copies of the Software Program, together with all
modifications, documentation, and merged portions in any form, or as otherwise described herein. Lexmark
may terminate your license upon notice if you fail to comply with any of the terms of this Software License
Agreement. Upon such termination, you agree to destroy all copies of the Software Program together with
all modifications, documentation, and merged portions in any form.

11 TAXES. You agree that you are responsible for payment of any taxes including, without limitation, any goods
and services and personal property taxes, resulting from this Software License Agreement or your Use of
the Software Program.

12 LIMITATION ON ACTIONS. No action, regardless of form, arising out of this Software License Agreement
may be brought by either party more than two years after the cause of action has arisen, except as provided
under applicable law.

13 APPLICABLE LAW. This Software License Agreement is governed by the laws of the Commonwealth of
Kentucky, United States of America. No choice of law rules in any jurisdiction shall apply. The UN Convention
on Contracts for the International Sale of Goods shall not apply.

14 UNITED STATES GOVERNMENT RESTRICTED RIGHTS. The Software Program has been developed
entirely at private expense. Rights of the United States Government to use the Software Program are as set
forth in this Software License Agreement and as restricted in DFARS 252.227-7014 and in similar FAR
provisions (or any equivalent agency regulation or contract clause).

15 CONSENT TO USE OF DATA. You agree that Lexmark, its affiliates, and agents may collect and use
information you provide in relation to support services performed with respect to the Software Program and
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requested by you. Lexmark agrees not to use this information in a form that personally identifies you except
to the extent necessary to provide such services.

16 EXPORT RESTRICTIONS. You may not (a) acquire, ship, transfer, or reexport, directly or indirectly, the
Software Program or any direct product therefrom, in violation of any applicable export laws or (b) permit
the Software Program to be used for any purpose prohibited by such export laws, including, without
limitation, nuclear, chemical, or biological weapons proliferation.

17 AGREEMENT TO CONTRACT ELECTRONICALLY. You and Lexmark agree to form this Software License
Agreement electronically. This means that when you click the “Agree” or “I accept” button on this page or
use this product, you acknowledge your agreement to these Software License Agreement terms and
conditions and that you are doing so with the intent to “sign” a contract with Lexmark.

18 CAPACITY AND AUTHORITY TO CONTRACT. You represent that you are of the legal age of majority in
the place you sign this Software License Agreement and, if applicable, you are duly authorized by your
employer or principal to enter into this contract.

19 ENTIRE AGREEMENT. This Software License Agreement (including any addendum or amendment to this
Software License Agreement that is included with the Software Program) is the entire agreement between
you and Lexmark relating to the Software Program. Except as otherwise provided for herein, these terms
and conditions supersede all prior or contemporaneous oral or written communications, proposals, and
representations with respect to the Software Program or any other subject matter covered by this Software
License Agreement (except to the extent such extraneous terms do not conflict with the terms of this
Software License Agreement, any other written agreement signed by you and Lexmark relating to your Use
of the Software Program). To the extent any Lexmark policies or programs for support services conflict with
the terms of this Software License Agreement, the terms of this Software License Agreement shall control.
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